# Table of Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EMS Web App User Guide</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>Get Started with the EMS Web App</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Log In and Out</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Log In</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Log Out</td>
<td>4</td>
</tr>
<tr>
<td>4</td>
<td>Check In To Events</td>
<td>6</td>
</tr>
<tr>
<td>5</td>
<td>Introduction to the Home Page</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Main Menu</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>My Home</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Site Home</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Not Available</td>
<td>12</td>
</tr>
<tr>
<td>7</td>
<td>Browse Events, Locations, and People</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>Learn how to:</td>
<td>15</td>
</tr>
</tbody>
</table>
CHAPTER 29: Change Account Information .......................................................... 118

CHAPTER 30: Establish Delegates ................................................................. 122

Add Delegates to Act As You ........................................................................ 123

For the EMS Web App User Who Will Act on Behalf of Another .................... 124

CHAPTER 31: Establish Booking Templates .................................................. 126

CHAPTER 32: Set Favorite Rooms ................................................................. 130

CHAPTER 33: Mobile Web App ..................................................................... 135

CHAPTER 34: Use the EMS Web App on Mobile Devices .............................. 136

Quick Tasks .................................................................................................. 138

Icons to Remember ....................................................................................... 139

What Is the Difference? ................................................................................ 139

Functional Limitations ................................................................................ 140


EMS Mobile App = EMS Application for Mobile Devices ............................ 142
CHAPTER 41: EMS for Outlook® (Optional Capability) ........................................ 152

CHAPTER 42: Integration with Exchange Enables You to Use Outlook® ........ 153

CHAPTER 43: Reservations, Bookings, and Booking Details ..................... 154

Reservation Structure ............................................................................. 154

Reservations .......................................................................................... 155

Booking Details ..................................................................................... 155

Event Timeline ....................................................................................... 156

Make a Reservation Using the Reservation Wizard .................................. 157

Specify the Event Date and Time Information ...................................... 158

Specify the Event Time and Status ....................................................... 161

Select the Event Location ...................................................................... 161

I. To search for a standard room: ......................................................... 162

II. To search for a best fit room: ............................................................ 164

III. To search for a specific room: ......................................................... 166

Specify the Event Information ............................................................... 169
View and Edit Reservations in the Reservation Book .................................................. 178

Open the Reservation Book .................................................................................. 179

Change the Reservation Book Display .................................................................. 180

View Reservation Information .............................................................................. 186

Make a New Reservation ...................................................................................... 188

Edit an Existing Reservation ................................................................................ 189

CHAPTER 44: Troubleshoot an Internal Server Error When Viewing My Events in EMS Web App ............................................................ 192

Contact Customer Support .................................................................................... 193

CHAPTER 45: Understand Everyday User Templates .............................................. 194

Why are some features in EMS unavailable to me? Why can't I book a room? ........ 194

CHAPTER 46: Skype for Business in the EMS Web App ......................................... 195

Add Skype for Business to Your Reservation ....................................................... 196

Join a Skype for Business Meeting from the EMS Web App ............................... 199
CHAPTER 1: EMS Web App User Guide

EMS Web App is an optional web application to access online. EMS Web App lets you see your schedule, create new reservations, and change existing reservations.

If you have deployed an older version of EMS Web App and are upgrading to the newest version, please encourage users at your facility to review {see What's New} before they begin working with the new version of the software. Doing so will streamline the adoption of the new release and help your users benefit from new features and functions that they might not otherwise discover.

The EMS Web App provides extensive space management functionality so that web users, including guests and temporary visitors, can view and book space while on-the-go, using any web browser.
CHAPTER 2: Get Started with the EMS Web App

EMS Web App is a web-based application that allows users to browse events in a calendar, view facility information, and if allowed, submit and manage room reservations and service requests. To get started, see the following topics:

» Log In and Out
» Check In To Events
» Introduction to the Home Page

Note: Upgrading Users may know EMS Web App as VEMS. For details about the enhancements in this new release, see What's New.
CHAPTER 3: Log In and Out

You can access EMS Web App through any standard Internet browser. This topic provides information on the following:

» Log In
» Log Out

LOG IN

1. Open an Internet browser session and navigate to your EMS Web App URL. (Contact your EMS Administrator if you need assistance.) The EMS Web App home page opens and prompts you to sign in.

   **TIP:** If your Administrator has enabled Guest Accounts, you can create a Guest Account using the green buttons to the right. When logged in through a Guest Account, you can request rooms; however, room requests must be approved by designated users in your organization.

2. In the Email Address field, enter the email address and password for your EMS User Account. Click for help with your password or contact your Administrator if you don't have one.
3. Click **Sign In**. The window changes to show your MY HOME and offer more options for creating reservations and for browsing events, locations, and people.

For an overview, see [Introduction to the Home Page](#).

---

**LOG OUT**

1. To log out, click the dropdown arrow under your name in the upper-right corner of the EMS Web App window.
2. Click **Sign Out**.
CHAPTER 4: Check In To Events

You can check in to your events in the MY EVENTS area on the EMS Web App main menu.

1. Click the Check In button next to the event (when available). Your Administrator sets a time limit on how soon you can check in before an event.
2. Once you have checked in to confirm your attendance, the booking shows on your MY HOME tab as **Checked In**.

![My Bookings](image)

**NOTE:** The Booking Level Check-In Role must be enabled in EMS Web App by your Administrator by adding the Check In/Check Out Role to a Web Security Template.

**NOTE:** In Version 44.1, several functions that were available in previous releases are no longer available, including: Building level Check-in/Check-out, check in a group via the Locate Group web menu, and the Check In/Check Out web menu.
CHAPTER 5: Introduction to the Home Page

Once you have signed into EMS, you will see a menu on the left and your home page on the right. To begin making a reservation, click **CREATE A RESERVATION**. To explore events, locations, and people, use the options under **BROWSE**.

Note: If not all options display or you are logged in as a Guest, you may need a User Account created by your Administrator.

MAIN MENU

The menu on the left enables you to:

» **CREATE A RESERVATION**
» **MY EVENTS** (shows your events in a calendar grid by Day, Month, or Date)
» **BROWSE**
  » **EVENTS** in a calendar grid
  » **LOCATIONS** (Buildings, Facilities, Regions, and Rooms)
» PEOPLE

» LINKS (your favorite shortcuts)

MY HOME

Information on your home page varies depending on your Administrator’s settings and User Preferences. For most users, the page shows three regions:

» My Reservation Templates - different types of reservations you can make
» My Bookings - your reservations
My Infographics - a summary of your activity

Tip: Anywhere you see "..." on a room name, you can click to expand and see the full room name.
SITE HOME

Clicking the SITE HOME tab will show your organization's customized EMS home page.
CHAPTER 7: Browse Events, Locations, and People

The BROWSE section of the main EMS Web App menu enables you to explore Events, Locations, and People.
LEARN HOW TO:

» Browse Events
» Browse Locations
» Locate People

Note: The previous version of this application, Virtual EMS (VEMS), had different menu options. See the following table for a comparison of VEMS and Web App menu options.

<table>
<thead>
<tr>
<th>MENU IN VEMS</th>
<th>MENU IN EMS WEB APP</th>
<th>How Is This Better?</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Requests</td>
<td>Events</td>
<td>Expands the view to all events, instead of only those you requested</td>
</tr>
<tr>
<td>Browse for Space</td>
<td>Locations</td>
<td>Expands the view to Facilities, Buildings, Views (custom collections of space), and Rooms</td>
</tr>
<tr>
<td>Browse Groups</td>
<td>People</td>
<td>Expands the view to Groups, individual Users, and custom user types</td>
</tr>
</tbody>
</table>
CHAPTER 8: Browse Events

You may wish to browse and explore existing events before you make a reservation in order to build familiarity with facilities, related or adjacent events, and other users' reservations. The BROWSE EVENTS page displays events in a daily (default), weekly, or monthly view.

Tip: To view and work with your own reservations and bookings, see View Your Events.

This topic provides information on the following:

» Browse Events Before Making a Reservation
» Browse Events Using Filters

BROWSE EVENTS BEFORE MAKING A RESERVATION

1. Click Browse > Events in the menu bar.
2. To browse existing events from BROWSE EVENTS, click on an event name. This
shows Event Details in a popup.
3. To see Room information, click the room name.

BROWSE EVENTS USING FILTERS

You can use filters along the top of the Browse Events window to narrow your results. These are explained below.
Tip: Your Administrator may have set up special preset views and filters for you. If you save your filter settings, they are remembered the next time you open the Browse Events page.

<table>
<thead>
<tr>
<th>VIEW</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily</td>
<td>Events scheduled for the current day's date in a list view.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Events scheduled for the current week (weeks always begin on a Sunday) in a list view.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Events that are scheduled for the current month in a calendar view.</td>
</tr>
</tbody>
</table>

To filter basic information, use the filters along the top of the window.

<table>
<thead>
<tr>
<th>BASIC FILTERS</th>
<th>HOW THEY WORK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>The date on which the view will focus.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>The time zone in which to display the schedule.</td>
</tr>
</tbody>
</table>

To filter in more detail, click the dropdown option.
<table>
<thead>
<tr>
<th>DETAILED FILTERS</th>
<th>HOW THEY WORK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locations</td>
<td>Browse only events for the location you select.</td>
</tr>
<tr>
<td>Room</td>
<td>Browse only events for the room you select.</td>
</tr>
<tr>
<td>Group</td>
<td>Browse only events for the group you select.</td>
</tr>
<tr>
<td>Event Name</td>
<td>Browse for a specific event by name.</td>
</tr>
<tr>
<td>Group Type</td>
<td>Browse for all events for a type of group you specify.</td>
</tr>
<tr>
<td>Room Types</td>
<td>Browse for events in a type of room you specify.</td>
</tr>
</tbody>
</table>
CHAPTER 9: Browse Locations

The EMS Web App LOCATIONS menu option helps you explore facilities and booked space and is especially useful when you know which space you want and need to find time slots when the space is available. Once you have located an available time slot, you can click CREATE A RESERVATION from the main menu to book space.

1. From the left menu in EMS Web App, click BROWSE > LOCATIONS. The Browse Locations page shows available rooms in a calendar view.

Tip: Filters along the top of the Browse Locations page enable you to
quickly focus the view on rooms in a specific time frame and by room features, such as equipment, room type, and geographic location. This helps you find available space to quickly meet your requirements. To add and remove location filters, click the **Add/Remove Locations** option, which presents a Locations filter popup where you can select by building, area, and view.
2. To learn more about a location, click the location name. The Location Details window appears (if you have permissions), showing details about the location.

3. Click **View All Building & Room Details** to see details. Depending on how your Administrator has configured your EMS Web App application, the window can show varying information about the location, including the building details (name, description, and/or notes), photos and floorplans (images), description, room type, setup type, and other features. (For detailed booking instructions, see [Create a Reservation in the EMS Web App](#).)

**TIP:** The LINKED TEMPLATES tab may be available depending on your implementation. This option will allow you to make a reservation for this room. Once you locate a room you wish to book, use this shortcut to quickly begin the process.
Anywhere you see "..." on a room name, you can click to expand and see the full room name.
CHAPTER 10: View Floor Plans

If your administrator has associated floor plans with spaces administrator has associated floor plans with spaces (which requires your organization to license and install the EMS Floor Plan Utility) when you browse for space by booking an event or viewing locations, you will see the floor plan icon next to the room. Click the floor plan to view visual details about the space.
You can click BROWSE > PEOPLE from the main EMS Web App menu to find a Group or Host who is scheduled to have a meeting, event, or workspace reservation. You can locate space in close proximity to a colleague with a workspace reservation or find the location of a meeting you are attending.

**NOTE:** Previous releases of EMS called this "Locate a group."

» **To search for a reservation hosted by a specific person or group,** enter at least the first three letters in the Name field (EMS Web App will suggest the closest match), and then click Search.

**TIP:** The Search field is not case-sensitive and you can search by any portion of the Group/person's name.

While the default number of search characters is three, this number can be configured by your EMS Administrator through the Minimum Characters to Initiate Type Ahead Search parameter. See Also: Everyday User Application Parameters.
**TIP:** From the results, you can click the Event Name for more details, to add to your personal calendar, or to share on social media. You can click the Location field for more information about the location including properties, applicable set-up types and corresponding capacities, and built-in features. You can click the Floor Plan icon to reveal where the location is situated on a floor map (requires module purchase and configuration).
CHAPTER 12: Event Details Page

To browse existing events from BROWSE EVENTS, click on an event name. This shows Event Details in a popup.

**TIP:** To add the event to your Outlook calendar, select *Add Event to Calendar* from the Event Details popup.
<table>
<thead>
<tr>
<th>EVENT DETAILS</th>
<th>RELATED EVENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Name</td>
<td>This is my event</td>
</tr>
<tr>
<td>Date</td>
<td>3/15/2016</td>
</tr>
<tr>
<td>Event Time</td>
<td>7:00 AM - 8:30 AM MT</td>
</tr>
<tr>
<td>Reserved Time</td>
<td>7:00 AM - 8:30 AM MT</td>
</tr>
<tr>
<td>Room</td>
<td>103</td>
</tr>
<tr>
<td>Group-X</td>
<td>24 Hour Fitness</td>
</tr>
<tr>
<td>1st Contact-X Name</td>
<td>Bob Anderson</td>
</tr>
<tr>
<td>1st Contact-X Phone</td>
<td>555</td>
</tr>
<tr>
<td>1st Contact-X Fax</td>
<td>555</td>
</tr>
<tr>
<td>1st Contact-X Email</td>
<td>&lt;a href=&quot;mailto:24.com&quot;&gt;24.com&lt;/a&gt;</td>
</tr>
</tbody>
</table>

Add Event To Calendar
Add to your Outlook calendar
CHAPTER 13: Create a Reservation in the EMS Web App

This topic provides information on creating a reservation in the EMS Web App:

» Create a Reservation
  » Specify When and Where
  » Specify Who and What
    » Choose Services (Optional)

» Finalize Reservation Details

» EMS for Outlook® (Optional Capability)

**NOTE:** For a conceptual overview, be sure to review the following:

» Reservations, Bookings, and Booking Details
» Reservation vs. Booking
» Ways to Make Reservations
» Booking Templates
CREATE A RESERVATION

1. You can begin making a reservation by clicking the CREATE A RESERVATION option (on the left menu) or the Book Now button next to one of your reservation templates (on the right).

2. Next, the Create a Reservation screen appears, where EMS Web App will lead you through the reservation process. Enter information (including all required fields) using the Next Step button to advance through the process.
SPECIFY WHEN AND WHERE

1. To specify When, select dates, times, recurrence (optional), and time zone for the reservation in the upper left panel.

2. To specify Where, in lower left panel, select one of the following:
   
   » Let Me Search for a Room
   
   OR
   
   » I Know What Room I Want

TIP: Filters in this lower left panel help you narrow your Room Search Results. When you click Search, results appear on the right. From these results, you can view expanded Room Details by clicking on the room name.

Locating space as part of the reservation process is different than browsing locations. See Also: Search for Available Rooms.
TIP: Once you have established favorites, EMS Web App uses these (plus the parameters of the booking template in use) to filter your search results when you use the Let Me Search For A Room option. To expand your search results beyond your favorites, de-select the Favorite rooms only checkbox or click Add/Remove next to Locations.

3. Once you have located a room to reserve, click the Add (+) icon to add the booking to your cart. You can delete or change the room before finalizing your Reservation.

TIP: If you are booking video conferences or multiple rooms, see Book a Video Conference Room and Book Multiple Rooms. Then, skip to Step 6.
SPECIFY WHO AND WHAT

4. In the Attendees area (near the center of the screen), specify headcount and attendees.

If your organization has installed and configured Integration to Microsoft® Exchange, you will be able to add or remove attendees and view attendee availability in the calendar grid of the Attendees section in the EMS Web App. Your attendees will also be sent invites after you finish creating the reservation. Attendees can be individuals, mailing lists, or groups; however, you cannot add attendees outside your domain. To see who is in a mailing list or group, add the list or group and click the (+) symbol next to the list or group in the calendar grid.
If your organization does not use Integration to Exchange, you will see a list of EMS Web App users and groups, but you will not see a calendar grid showing their availability.

**TIP:** Adding attendees to an event is different than browsing people. For detailed instructions on using the BROWSE PEOPLE option from the main menu. See Also: Searching for People.

**TIP:** If available, select a Setup Type (if available) for the reservation; this associates likely services and features with bookings.

5. Once you complete all required fields on this tab, click Next Step in the upper-right corner.
**NOTE:** Choose Services is an optional feature based on the booking template you use. Services include room setup and teardown, equipment, and any other services you wish to associate with a room. Your Administrator sets which services can be associated with a room and with an event type.

6. Under the **Services** tab in the Create Reservation screen, specify any services you wish to associate with the reservation (if available, you can click **Skip Services**). The example below showing a workspace booking may differ from your administrator settings, such as catering options and billing.
7. When complete, click **Next Step** in the upper right corner.

**FINALIZE RESERVATION DETAILS**

The Reservation Details screen finalizes information about your reservation. Invitations to bookings and attachments will be sent to all attendees. The example shown below may differ from your implementation. For an in-depth overview of this part of the booking process, see [Add Reservation Details](#).
8. Complete all required information. Then click **Save Reservation Details** and **Create Reservation**.

**TIP:** To add the reservation to your Outlook calendar, click the **Add this reservation to my calendar** checkbox at the bottom of the window.
EMS FOR OUTLOOK® (OPTIONAL CAPABILITY)

EMS for Outlook® is an optional (extra cost) purchase. If your organization has purchased it, then you will see the EMS add-in icon in your Outlook application. You will also see additional features and functionality in EMS. Furthermore, anywhere that you see people or groups in EMS, you will have access to everyone in your organization's email database (which is stored in Exchange Server). This means that you can see people's availability (Out of Office, Busy, In a Meeting, etc.), send them email invitations or notices, and add EMS events to your Outlook calendar.
CHAPTER 14: Ways to Make Reservations

The EMS Web App provides several ways for you to make a new room request or event reservation:

1. REQUEST A RESERVATION

If you logged in as a guest, you can submit a reservation request that will be approved by an authorized EMS Web App user.

2. CREATE A RESERVATION

Click CREATE A RESERVATION from the main menu. Then select a template to streamline the booking process and browse for available time slots and rooms.

3. BOOK NOW USING YOUR TEMPLATE

Click the Book Now button next to the template you prefer from your homepage, and then browse for available time slots and rooms.
4. BROWSE AND THEN BOOK

Click **BROWSE** (main menu):

» Browse **EVENTS**. Then request a reservation or, if authorized, click CREATE A RESERVATION from the main menu and select a template to streamline the booking process.

OR

» Browse **LOCATIONS**, find the room you want, and click on any blank slot in the room's calendar. Then select a template to streamline the booking process.

Tip: First Browse and Then Book. To familiarize yourself with the locations in your organization, try **Browse Events, Locations, and People**
before requesting rooms or making reservations. Exploring the EMS Web App this way helps you explore available space, view the schedule at a high level, and understand how other users in your organization reserve rooms. You can also establish your own naming conventions for your events and narrow down your searches to specific room types, room features, event types, geographical areas, and so on.

Concepts: Booking Templates, Requests, and Reservations. 

- **Templates**: Your My Account settings contain reservation Templates created by you or your Administrator to streamline the process of booking events. Rooms and workspaces are individually set to work with various types of booking templates by your Administrator.

- **Requests vs. Reservations**: Depending on your permissions, you may Request a Room or Make a Reservation. Room requests require approval from a more supervisory user, and are visible to other users so they know the space has been tentatively booked. The EMS Web App behaves differently for each type of user, showing fewer options (and usually, less information) for those who can only request rooms.
THE RESERVATION PROCESS: WHO AND WHAT, WHERE AND WHEN

What's the difference between a "reservation" and a "booking?" A Reservation consists of one or more Bookings. That's it.

Every booking belongs to a reservation. EMS lets you have multiple bookings under a single reservation. When you have multiple bookings in a reservation, each booking can be independent of the other, such as reserving a set of rooms for an event, or can be a series of bookings under a Recurring reservation.

Each booking can contain multiple Booking Details, which are the resources and services required to support the booking, such as catering and room setup.
A reservation is the "who and what" of an event. For example, the Academic Planning Board (the who) may reserve space for a Semester Kickoff event (the what).
BOOKINGS: WHERE AND WHEN

A *booking* is the "where and when" of an event. For example, the Academic Planning Board schedules the conference room (the where) for a staff meeting on the second Monday in January (the when). The Academic Planning Board now has a single reservation with a single booking in EMS. If, however, they schedule the conference room (the where) for a staff meeting on the second Monday of each month for a year (the when), then the board now has a single reservation with 12 bookings.

**BOOKING DETAILS**

A booking can have one or more booking details associated with it. *Booking details* are the resources (items for the meeting) or services (people and their activities) that are needed for an event, the notes for the event, the activities for the event, the room charges for the event, or any combination of these. For example, for the Academic Planning Board’s staff meeting, the resources could include catering (coffee service, bagels and muffins, and so on) and A/V equipment, plus the services of a person bringing in and setting up a projector, moving a speaker’s podium, and so on).
SERVICE ORDERS

System Administrators configure "buckets" of these details as "Categories," which streamlines the process of adding details to bookings.

**Concept: Services, Categories, and Resources: What's the Difference? Click for more...**

In EMS, you may hear these terms used interchangeably sometimes, however, they are different concepts.

A *Category* in EMS is anything you might add to a Booking such as Catering, Audio Visual, Furniture, Security, Notes, Attendee Names, Agendas etc. When you configure a Category, however, it must be of six *Category types*: Activities, Attendees, Catering, Notes, Resources with Service Orders, or Resources Without Service Orders. These types cause the service to behave slightly differently when added to a booking. For example, a Notes/Activities/Attendees type service category does not require the EMS Administrator to configure items under it, and there is nothing for a person to “select” from these types of services.

By contrast, a service category that has a type of Catering, Resource with Service Order, or a Resource without a Service Order Category, will require the Administrator to create items under it. For example, an "AV Equipment" service
category (configured as a Resource without a Service Order Category type) might have items under it such as a flip chart or whiteboard (under AV Equipment). The person requesting the service for this meeting would then select **AV equipment**; then **flipchart** and **whiteboard** would be typical options to add to the event.

**TIP:** The following Category Types allow **Production Items:** Catering, Resources with Service Orders, and Resources Without Service Orders.

Furthermore, a Category can be **configured to "Use States"** so that when a service is requested with a meeting, it can be managed through a review and approval process in the Manage Services toolbar option in EMS Desktop Client.

See Also: **Add Booking Details Wizard.**
CHAPTER 15: View Your Events

**IMPORTANT:** The VIEW EVENTS option is different than the BROWSE EVENTS option in the main menu. To learn more, see [MY EVENTS vs. BROWSE EVENTS](#).

You can quickly view your events, reservations, and requests on both your MY HOME page as well as your MY EVENTS page.

1. Click **My Events** to see your reservations and bookings. The default view for My Events is dependent on the configuration done by your EMS Administrator. This configuration is done in the EMS Desktop Client through the **My Events Default View** parameter. See Also: [EMS Everyday User Applications Parameters](#).
2. To view or edit a reservation, click the name of the reservation. See Also: Create a Reservation in the EMS Web App.

TIP: EMS only returns search results that contain the exact order of the characters in your search string, but EMS does not care about if your search string is uppercase or lowercase. In addition, EMS will return search results that contain your search string regardless of where those characters appear. For example, a search string of ed returns the College of Education Seminar, Ed Smith fundraiser, Health Center Education Training, and so on.

NOTE: The BROWSE > EVENTS menu option shows all of your
reservations, as well as all reservations that you are authorized to view. The **MY EVENTS** menu option shows the reservations you have created. It will not display reservations to which you have been invited.

3. To view reservation and booking details, click on an event name. Event details display—bookings within the reservation show in the lower half of the screen.
CHAPTER 16: Search for Available Rooms

During the booking process, you can search for available rooms on the Room Request page in two ways: **Let Me Search For A Room** or **I Know What Room I Want**.

To search for available rooms, do the following:

1. From the Create a Reservation screen, in the Bookings area, select one of the following:
   
   » **Let Me Search For A Room**
   
   OR
   
   » **I Know What Room I Want**
Tips: Filters in the left panel help you narrow your Room Search Results. When you click **Search**, results appear on the right. From these results, you can view expanded Room Details by clicking on the room name, and you can view any available floor plans by clicking the floor.
You can click the Add/Remove buttons next to Locations, Floors, Setup Types, and Features to add or expand your filters. To set Favorite Rooms to use every time, see **Set Favorite Rooms**.

Locating space as part of the reservation process is different than browsing locations. For detailed instructions on using the BROWSE LOCATIONS option in the main menu to view available and booked space, see **Browse Locations**.

2. To filter your search by Location, click **Add/Remove** next to **Location**. This presents a list of locations by Building or view. Select the locations filters you wish to apply (or search by keyword), and then click **Update Locations**. This filters the results of your keyword search on the Add New Favorite Room dialog (above). Your filter settings are saved, and you will have to go back in and remove them if you wish to expand search results beyond these locations.
3. Once you have located a room to reserve, click the Add (+) icon to add it to your reservation. This adds the booking to your cart. You can change your mind and delete or change the room for the booking before you finalize your reservation.
CHAPTER 17: Book Multiple Rooms

During the reservation process, you can select more than one room (if the template you are using permits it).

1. Once you have found available rooms, click the Add (+) icon to move each room into the Selected Rooms area. You can repeat this for each room you want to add to your reservation.
2. As you book each room, EMS will prompt you to enter attendees and setup type as follows:

   a. Enter the headcount in the **No. of Attendees** field.
   
   b. Select a setup type from the **Setup Type** dropdown list.
   
   c. Click the **Add Room** button to book the room.
3. Click **Next Step** to continue with the booking process.
CHAPTER 18: Book Recurring Meetings

This topic provides information on booking recurring meetings in the EMS Web App.

» Create a Reservation for Recurring Meetings
  » Specify When and Where
  » Specify Who and What
    » Choose Services (Optional)
    » EMS for Outlook® (Optional Capability)

» Finalize Reservation Details

NOTE: For a conceptual overview, be sure to review the following topics:

» Ways to Make Reservations
» Reservations, Bookings, and Booking Details
CREATE A RESERVATION FOR RECURRING MEETINGS

1. You can begin making a reservation by clicking the **CREATE A RESERVATION** option (on the left menu) or the **Book Now** button next to one of your reservation templates (on the right).

2. Next, the Create a Reservation screen launches, where EMS Web App will lead you through the reservation process.

3. Enter your information (including all required fields) and click the **Next Step** button.
to advance through the process.

SPECIFY WHEN AND WHERE

1. To specify *When*, select dates and times.

2. Click the *Recurrence* button.

   a. Follow the prompts to select the frequency, date range, day of the week, start and end times, and time zone for the recurrence.
b. Click **Apply Recurrence** to validate your entries and return to the New Booking screen.

**TIP:** Once booked, each meeting will show as a single Booking in your My Bookings area on MY HOME. Also, note that the **Create Booking In** field specifies the time zone in which to book the meeting, which may differ from your system time zone.

3. To specify Where, in lower left panel, select one of the following:

« Let Me Search For A Room

OR

« I Know What Room I Want
Tip: Filters in this lower left panel help you narrow your Room Search Results. When you click Search, results appear on the right. From these results, you can view expanded Room Details by clicking on the room name.

Locating space as part of the reservation process is different than simply browsing locations. For detailed instructions on using the BROWSE LOCATIONS options in the main menu, see Search for Available Rooms.

4. Once you have located a room to reserve, click the Add (+) icon to validate and add the booking to your cart. You can delete or change the room before you finalize your reservation.

SPECIFY WHO AND WHAT

1. In the Attendance area (near the center of the screen), select a Setup Type (if available) for the reservation from the dropdown.
2. Specify headcount and attendees in the Attendance area.

   » If your organization has implemented EMS for Outlook, you use the optional Attendees section to add or remove attendees and send them invitations or notifications. Attendees can be individuals or mailing lists or groups. To see who is in a mailing list or group, simply expand it. This optional feature enables you to view attendees' availability and add or subtract them from the event.

   » If your organization has not implemented EMS for Outlook, you will see a list of EMS Web App users and groups but you will not see availability.

Tip: Adding attendees to an event is different than browsing people. For detailed instructions on using the BROWSE PEOPLE option from the main menu, see Locate People.
3. Once you have completed all required fields, click **Next Step** in the upper right corner.

**CHOOSE SERVICES (OPTIONAL)**

This is an optional feature based on the booking template you use. Services include room setup and teardown, equipment, and any other services you wish to associate with a room. Your Administrator sets which services can be associated with a room and with an event type.

1. Under the **Services** tab in the Create Reservation screen, specify any services you wish to associate with the reservation, or click **Skip Services**.
2. When complete, click **Next Step** in the upper-right corner.

**EMS FOR OUTLOOK® (OPTIONAL CAPABILITY)**

EMS for Outlook® is an optional (extra cost) purchase. If your organization has purchased it, then you will see the EMS add-in icon in your Outlook application. You will also see additional features and functionality in EMS. Furthermore, anywhere that you see people or groups in EMS, you will have access to everyone in your organization's email database (which is stored in Exchange Server). This means that you can see people's availability (Out of Office, Busy, In a Meet-
ing, etc.), send them email invitations or notices, and add EMS events to your Outlook calendar.

**FINALIZE RESERVATION DETAILS**

The Reservation Details screen finalizes information about your reservation. Invitations to bookings and attachments will be sent to all attendees.

Complete all required information and click **Save Reservation Details**, and then **Create Reservation**.

**TIP:** To add the reservation to your Outlook calendar, click the **Add this reservation to my calendar** checkbox at the bottom of the window.
CHAPTER 19: Book a Video Conference Room

Typically, video conference bookings involve at least two Rooms: the "host" Room where the meeting host user is located and at least one more additional Room where other attendees gather to participate. If you begin a Reservation or Booking using a video conferencing process template, you will be prompted during the booking process to confirm which one of your Rooms is the Host. The first Room you select will be automatically selected as the Host, but you can change the Host to a different Room once that additional Room is selected. You can select only one Room per Building. You can also specify a different head-count for each Room.

Tip: You may need to add multiple meeting Rooms, including the Host, to the Reservation. If all participants including the host gather in the same Room, however, you will only need one Room. Simply designate this sole Room as the Host.
CHAPTER 20: Book a Desk or Workspace in the EMS Web App

This topic provides information on booking a desk or workspace in the EMS Web App.

» Create a Reservation for a Desk or Workspace
  » Specify When and Where
  » Specify Who and What
    » EMS for Outlook (Optional Capability)
  » Finalize Reservation Details

NOTE: For a conceptual overview, be sure to review:

» Ways to Make Reservations
» Reservations, Bookings, and Booking Details
CREATE A RESERVATION FOR A DESK OR
WORKSPACE

1. You can begin making a reservation by clicking the CREATE A RESERVATION option (on the left menu) or the Book Now button next to one of your reservation templates (on the right).

2. Next, the Create a Reservation screen launches, where EMS Web App will lead you through the reservation process.

3. Enter your information (including all required fields) and click the Next Step button
to advance through the process.

**SPECIFY WHEN AND WHERE**

1. To specify *When*, select dates and times.
   a. If you wish to book space for multiple time slots, click the **Recurrence** button.

   ![Create A Reservation](image)

   ![New Booking for Thu May 5, 2016](image)

   b. Follow the prompts to select the frequency, date range, day of the week, start and end times, and time zone for the recurrence.
c. Click **Apply Recurrence** to validate your entries and return to the New Booking screen.

**TIP:** Once booked, each meeting will show as a single Booking in your My Bookings area on MY HOME. Also, note that the **Create Booking In** field specifies the time zone in which to book the meeting, which may differ from your system time zone.

2. To specify **Where**, in lower left panel, select one of the following:

  » Let Me Search For A Room

  OR

  » I Know What Room I Want
3. Once you have located space to reserve, click the Add (+) icon to validate and add the booking to your cart. You can delete or change the room before you finalize your reservation.

SPECIFY WHO AND WHAT

To specify the setup type and attendees for your reservation, do the following:

1. In the Attendance area (near the center of the screen), select a Setup Type (if available) for the reservation from the dropdown.
2. Specify headcount and attendees in the Attendance area. If you are the only attendee, you may be able to skip this step.

   » If your organization has implemented EMS for Outlook, you use the optional Attendees section to add or remove attendees and send them invitations or notifications. Attendees can be individuals or mailing lists or groups. To see who is in a mailing list or group, simply expand it. This optional feature enables you to view attendees’ availability and add or subtract them from the event.

   » If your organization has not implemented EMS for Outlook, you will see a list of EMS Web App users and groups but you will not see availability.

3. Once you have completed all required fields, click **Next Step** in the upper right corner.
EMS FOR OUTLOOK® (OPTIONAL CAPABILITY)

EMS for Outlook® is an optional (extra cost) purchase. If your organization has purchased it, then you will see the EMS plugin icon in your Outlook application. You will also see additional features and functionality in EMS. Further, anywhere that you see people or groups in EMS, you will have access to everyone in your organization's email database (which is stored in Exchange Server). This means that you can see people's availability (Out of Office, Busy, In a Meeting, etc.), send them email invitations or notices, and add EMS events to your Outlook calendar.

See Also: Checking In

FINALIZE RESERVATION DETAILS

The Reservation Details screen finalizes information about your reservation. Invitations to bookings and attachments will be sent to any attendee you invites. The example shown below may differ from your implementation.

1. To browse existing events from BROWSE EVENTS, click on an event name. This shows Event Details in a popup.
2. Complete all required information and click **Save Reservation Details** and then click **Create Reservation**.

**TIP:** To add the reservation to your Outlook calendar, click **Add Event To Calendar** at the bottom of the window.
CHAPTER 21: Add Reservation Details

If you open an existing reservation or create a new one, the Reservation Summary page opens. This area enables you to modify bookings within a reservation, such as requesting services and adding attendees. This topic provides information about the following:

- Reservation Details
- Reservation vs. Booking
  - Reservations: Who and What
  - Bookings: Where and When
    - Booking Details
    - Service Orders

- Reservation Tasks
- Attachments
- Bookings for the Reservation
RESERVATION DETAILS

The Reservation Details option displays detailed summary information (the Reservation ID, the Event Name, the Event Type, and so on) for the selected reservation and all its bookings as well as attendees and any services that were requested for the bookings.

RESERVATION VS. BOOKING

What's the difference between a "reservation" and a "booking?" A Reservation consists of one or more Bookings. That's it.

Every booking belongs to a reservation. EMS lets you have multiple bookings under a single reservation. When you have multiple bookings in a reservation, each booking can be independent of the other, such as reserving a set of rooms for an event, or can be a series of bookings under a Recurring reservation.
Each booking can contain multiple *Booking Details*, which are the resources and services required to support the booking, such as catering and room setup.

**RESERVATIONS: WHO AND WHAT**

A *reservation* is the "who and what" of an event. For example, the Academic Planning Board (the who) may reserve space for a Semester Kickoff event (the what).
BOOKINGS: WHERE AND WHEN

A booking is the "where and when" of an event. For example, the Academic Planning Board schedules the conference room (the where) for a staff meeting on the second Monday in January (the when). The Academic Planning Board now has a single reservation with a single booking in EMS. If, however, they schedule the conference room (the where) for a staff meeting on the second Monday of each month for a year (the when), then the board now has a single reservation with 12 bookings.

BOOKING DETAILS

A booking can have one or more booking details associated with it. Booking details are the resources (items for the meeting) or services (people and their activities) that are needed for an event, the notes for the event, the activities for the event, the room charges for the event, or any combination of these. For example, for the Academic Planning Board’s staff meeting, the resources could include catering (coffee service, bagels and muffins, and so on) and A/V equipment, plus the services of a person bringing in and setting up a projector, moving a speaker’s podium, and so on).
SERVICE ORDERS

System Administrators configure "buckets" of these details as "Categories," which streamlines the process of adding details to bookings.

Concept: Services, Categories, and Resources: What's the Difference? Click for more...

In EMS, you may hear these terms used interchangeably sometimes, however, they are different concepts.

A Category in EMS is anything you might add to a Booking such as Catering, Audio Visual, Furniture, Security, Notes, Attendee Names, Agendas etc. When you configure a Category, however, it must be of six Category types: Activities, Attendees, Catering, Notes, Resources with Service Orders, or Resources Without Service Orders. These types cause the service to behave slightly differently when added to a booking. For example, a Notes/Activities/Attendees type service category does not require the EMS Administrator to configure items under it, and there is nothing for a person to “select” from these types of services.

By contrast, a service category that has a type of Catering, Resource with Service Order, or a Resource without a Service Order Category, will require the Administrator to create items under it. For example, an "AV Equipment" service
category (configured as a Resource without a Service Order Category type) might have items under it such as a flip chart or whiteboard (under AV Equipment). The person requesting the service for this meeting would then select **AV equipment**; then **flipchart** and **whiteboard** would be typical options to add to the event.

```
Tip: The following Category Types allow Production Items: Catering, Resources with Service Orders, and Resources Without Service Orders.
```

Furthermore, a Category can be **configured to "Use States"** so that when a service is requested with a meeting, it can be managed through a review and approval process in the Manage Services toolbar option in EMS Desktop Client.

```
Tip: You may be able to see floorplans for rooms. See Also: View Floor Plans.
```
RESERVATION TASKS

Use the **Reservation Tasks** area to take available actions on this event:

<table>
<thead>
<tr>
<th>Reservation Task</th>
<th>What You Can Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Booking Tools</td>
<td></td>
</tr>
<tr>
<td>Cancel Reservation</td>
<td>Cancel the reservation.</td>
</tr>
<tr>
<td>View Service Availability</td>
<td>Opens a Service Availability window where you can choose from allowable booking templates to add services.</td>
</tr>
<tr>
<td>Send Invitation</td>
<td>Sends invitations to recipients you specify.</td>
</tr>
<tr>
<td>Add to my Calendar</td>
<td>Adds the reservation and all its bookings to your personal (Outlook) calendar.</td>
</tr>
</tbody>
</table>

ATTACHMENTS

The **Attachments** tab is available if the reservation type required attachments. It provides the attachment description, file name, and notes about the attachment. You can:
Delete an attachment from a reservation or request.

Attach another file to the reservation or request, click Attach File. A dialog box opens where you can select the attachment. Allowed formats are .csv, .doc, .gif, .pdf, .txt, .xls, .xlsx, and .tif.

BOOKINGS FOR THE RESERVATION

The lower portion of the Reservation Summary page shows bookings for this reservation and (if you have permissions) enables you to add another booking, edit or delete existing bookings, and take other actions on those bookings.

<table>
<thead>
<tr>
<th>ACTION</th>
<th>RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Cancel selected bookings for the reservation.</td>
</tr>
<tr>
<td>Booking</td>
<td></td>
</tr>
</tbody>
</table>

Attendance Booking headcount.

Setup Type Setup Types are defined by your Administrator, and define which services, resources, and room types can be used for the booking.

Status Stage in the booking process for the booking, such as Requested, Reserved, Pending.
CHAPTER 22: Add Services to a Meeting

1. To add services to an existing event, click on My Events and open the reservation you wish to edit.

2. Click Add Services to add these details to the meeting. This option is only available if your Administrator allows it for this type of meeting and for your user profile.

Tip: Once you have added services and reserved space, you can work with services by clicking Manage Services.
3. The first screen shows attendees and any existing services for the meeting and click on services you wish to add from the list of available options.

4. When you click a service to add, a popup screen may prompt you to specify a quantity for the item and add notes, special instructions, and so on. Click OK to save your changes.
5. The right panel of the Select Services window updates to show your latest additions. When you have added all services for the meeting, click the **Next Step** button.

6. The next screen lists all bookings within the reservation you selected from My Events. Select the booking to which you wish to add services (if the reservation includes multiple booking, they are all listed here for you to select), and click
7. You return to the Reservation page and a confirmation appears briefly confirming your changes.
CHAPTER 23: Work with Services

This topic provides information on the following:

» Services, Categories, and Resources
» Add Services to a New Reservation
» Change or Cancel Services for an Existing Reservation

SERVICES, CATEGORIES, AND RESOURCES

In EMS, you may sometimes hear the terms Services, Categories, and Resources used interchangeably; however, they are different concepts.

CATEGORIES

A Category in EMS is anything you might add to a Booking such as Catering, Audio Visual, Furniture, Security, Notes, Attendee Names, Agendas etc. When you configure a Category, however, it must be of six Category types: Activities, Attendees, Catering, Notes, Resources with Service Orders, or Resources Without Service Orders. These types cause the service to behave slightly differently when added to a booking. For example, a Notes/Activities/Attendees type service category does not require the EMS Administrator to configure
items under it and there is nothing for a person to “select” from these types of services.

**SERVICE CATEGORY**

By contrast, a service category that has a type of Catering, Resource with Service Order, or a Resource without a Service Order Category, will require the Administrator to create items under it. For example, an "AV Equipment" service category (configured as a Resource without a Service Order Category type) might have items under it such as a flip chart or whiteboard (under AV Equipment). The person requesting the service for this meeting would then select **AV equipment**; then flipchart and whiteboard would be typical options to add to the event.

**TIP:** The following Category Types allow **Production Items:** Catering, Resources with Service Orders, and Resources Without Service Orders.

Furthermore, a Category can be **configured to "Use States"** so that when a service is requested with a meeting, it can be managed through a review and approval process in the Manage Services toolbar option in EMS Desktop Client.
NOTE: If you are using the EMS Web App on a mobile device, you will not have access to this feature. See Also: Categories, Resources, and Services: What's the Difference?

ADD SERVICES TO A NEW RESERVATION

1. While creating a new reservation, navigate to the Services tab. The services your administrator has defined as available for the booking template and room(s) you selected are listed on the left panel.

   TIP: If you are editing an existing reservation, click the Add Services option in the Reservation Tasks menu on the right, or open the Reservation Details and select the Services tab.

2. Click the Services dropdown to expand and pick a service. You can add resources with service orders, catering (food) services, resources without service orders, setup notes and/or a room charge. You can add multiple services to a reservation and to a booking.
TIP: Options available in the Services dropdowns depend on several factors leading up to this stage in the booking process: your booking template parameters, setup type, and other rules set by your System Administrator.

3. Enter the necessary information for the services you are adding to the reservation.

NOTE: Required fields are marked with red. You may need to add information such as the start and end times, the estimated count, and so on. You may also have to answer service-specific questions, and/or have to agree to Terms and Conditions.
4. At the bottom of the page, click **Next Step**. The Available Services tab closes. You advance to the Reservation Details tab.

» If the reservation has only this single booking, a confirmation message displays. Click **OK** to close the message and return to the Booking Details tab. The newly added booking detail shows on the Existing Services tab.

» If the reservation has multiple bookings, then choose whether to add services to just the one booking, or several:

» To add the services to only this booking, click **Do Not Apply** to Additional Bookings. You remain on the Booking Details tab. The newly added services show on the Existing Services tab.

» To add the services to one or more of the other bookings in the reservation, select them (you can select all using the checkbox in the Date column heading), and then click **Save**. A confirmation message displays. Click **OK** to close and return to the Booking Details tab. The newly added services now show on the Existing Services tab.
CHANGE OR CANCEL SERVICES FOR AN EXISTING RESERVATION

From an existing booking within one of your reservations, click the Manage Services option (if available) under the Bookings list. This enables you to change or cancel (delete) services for a booking, individually, per service item, or by service category.

On the Manage Services page that presents, you can subtract (-) services from the Services Summary view (if enabled). Services are listed in the right panel by category.
NOTE: The event type and the booking status (as well as your Administrator settings) affect whether the Manage Services option is available.
CHAPTER 24: Cancel Your Reservations and Bookings

This section guides you to work with bookings in the Reservation Details page on EMS Web App, where you can view, add, change, or cancel services and attendees for a booking. For an overview, see Add Reservation Details. A reservation may contain multiple bookings, so the procedures below guide you in applying your changes to more than one booking within a reservation.

This topic provides information on the following:

» Cancel Reservations
» Cancel Bookings

CANCEL RESERVATIONS

1. Navigate to the reservation with which you wish to work: click MY EVENTS on the main EMS Web App menu (or from the My Bookings area on MY HOME). Then click on a Reservation.
TIP: When you click to edit a Reservation or Booking, the page that opens depends upon the type of booking that you are editing—a booking for reserving a room, a booking for requesting a room, or a booking for services only.

2. From the Reservation Details page, click Cancel Reservation.
WARNING: Canceling a reservation will also cancel all bookings under the reservation.

3. In the **Cancel Reservation** popup that appears, select a **Cancel Reason**, add **Cancel Notes**, and then confirm that you want to cancel.

4. Your MY EVENTS pages refreshes, and the reservation is canceled.

**CANCEL BOOKINGS**

1. From the **Reservation Details** page in the Bookings area, to cancel a single booking, click the date of the booking or the **Remove (-)** icon next to the booking. These options are available if your administrator has given you permission.
TIP: To cancel *multiple bookings*, click **Cancel Bookings** in the upper corner of your My Events list.

2. In the **Cancel Booking** popup that appears, select a **Cancel Reason**, add **Cancel Notes**, and then confirm that you want to cancel.
3. Your MY EVENTS page refreshes and the booking is canceled.
CHAPTER 25: Edit Reservations and Bookings

This section guides you in working with bookings in the Reservation Details page on EMS Web App, where you can view, add, change, or cancel services and attendees for a booking. For an overview, see Add Reservation Details. A reservation may contain multiple bookings, so the procedures below guide you in applying your changes to more than one booking within a reservation.

The process for editing reservations and bookings for Exchange-enabled templates and non-Exchange-enabled templates are different. This topic includes the following information:

» Edit Reservations
» Edit Booking (Exchange-enabled Template)
» Edit Bookings (Non-Exchange-enabled Template)

EDIT RESERVATIONS

Concept: Reservations and Bookings: What Is the Difference? (Click to Expand)
A Reservation is the purpose of the event. In EMS, a reservation is the who (the meeting organizer) and the what of an event. A Reservation contains one or more Bookings. For example, you (the who) can reserve some space for a staff meeting (the what).

A Booking is the where and the when of an event. For example, you can schedule the large auditorium (the where) for a staff meeting on the second Monday in January (the when). There are one or more Bookings in a Reservation.

To edit a reservation:

1. To navigate to the reservation you wish to edit, click **My Events** on the side bar of the Home page.

   *Use the My Events Link to Find Your Reservations*
2. Click on the reservation name you wish to edit.

3. To edit reservation details, navigate to Reservation Details > Reservation Details tab.

4. Click the Edit Reservation Details link.

   **Edit Reservation Details Page**

5. Edit any available field.

6. Click the Save Reservation Details buttons at either the bottom or top right hand of the page.

   **TIP:** When you click to edit a Reservation or Booking, the page that opens depends upon the type of booking that you are editing—a booking for reserving a room, a booking for requesting a room, or a booking for services.
NOTE: If there is Additional Information (e.g., user-defined fields) associated with your reservation, you can edit this information by navigating to the Additional Information Tab from the Reservation Details page. Click the Edit Additional Information button.

EDIT BOOKING (EXCHANGE-ENABLED TEMPLATE)

IMPORTANT: Users are unable to edit the date and time from the Room Request screen. The date and time can be edited from the Manage Bookings screen.

1. From the Home page, navigate to the My Events page.
2. Click on the Reservation Name for the reservation you wish to edit.
3. Click Edit icon next to the booking you wish to edit. The Manage Bookings page appears.
4. From the Manage Bookings page, you can:

   I. Edit/replace the room:

      a. Click on the **Edit** icon next to the room to change the location. The user is routed to the **Room Request** screen.

      b. Click **Search** to display the list of available rooms.

      **NOTE:** In the example below, Demo Room 03 does not have an **Add (+)** button because it was the original room for this booking.

   ![Room Request Screen](image)

      c. To choose a room, click the **Add (+)** button.

      d. Click **Update Booking** to save that location to your booking.
e. When the Manage Bookings screen appears, click **Update Bookings** again on this page.

f. You will receive a prompt to **Notify Attendees**. Click either **Notify Change** (this will send a calendar update to added or removed attendees), **Notify All** (this will send a calendar update to ALL attendees), or **Cancel**.

g. Changes are applied, attendees are notified, and the calendars of both attendees and the organizer are updated.

II. **Edit the time/date of the booking:**
   
a. Click on the reservation Name for the reservation you wish to edit.

b. Click **Edit** icon next to the booking you wish to edit. The Manage Bookings page appears.

c. Edit the **Date & Time** of the booking in the left-hand column.

d. If the room is available for this new time, click **Update Bookings**.

e. If the room is not available for the new time, either select a new time or edit the room for the booking (see above).

III. **Add an additional location to the same booking:**
   
a. Click on the reservation name for the reservation you wish to edit.

b. Click **Edit** icon next to the booking you wish to edit. The **Manage Bookings** page appears.
c. Click **Add Location**. The Room Request screen appears.

**Add Additional Location**

![Room Request Screen](image)

**NOTE:** All locations within the same booking will have the same Start and End time.

d. Click **Search** to display the list of available rooms.

e. Select a room(s) using the **Add (+)** button.

f. Click **Done**. The Manage Bookings page appears.

g. Click **Update Bookings**.

h. A prompt will appear to **Notify Attendees**. Click either **Notify Change** (this will send a calendar update to added or removed attendees),
Notify All (this will send a calendar update to ALL attendees),
or Cancel.

i. Changes are applied, attendees are notified, and the calendars of both attendees and the organizer are updated.

IV. Modify attendees in this booking:

a. Click on the reservation Name for the reservation you wish to edit.
b. Click the Edit icon next to the booking you wish to edit. The Manage Bookings page appears.
c. Navigate to the Attendee section.
d. Type in the attendee name in the text field. The system will create a dropdown list of names that match the search.
e. Select a name. This attendee will be added to your booking.
f. Click Update Subject/Message and Notify Attendees.
g. Click either Notify Change (this will send a calendar update to added or removed attendees), Notify All (this will send a calendar update to ALL attendees), or Cancel.
h. Changes are applied, attendees are notified, and the calendars of both attendees and the organizer are updated.
EDIT BOOKINGS (NON-EXCHANGE-ENABLED TEMPLATE)

From the Reservation Details page in the Bookings area, you can edit one booking or multiple bookings.

TO EDIT THE DATE AND TIME ON A SINGLE OR ON MULTIPLE BOOKINGS

1. Click the Booking Tools link under the Reservation Tasks section on the right hand side of this page. You can also edit the date and time on multiple bookings by clicking on the Booking Tools link under the Bookings section.

Use the Reservation Tasks and Bookings Sections to Edit Multiple Bookings
2. Make any necessary edits.

3. Click **Update Bookings**.

**TO EDIT THE LOCATION AND/OR DATE AND TIME ON A SINGLE BOOKING**

1. To navigate to the reservation you wish to edit, click **My Events** on the side bar of the Home page.

2. Click on the reservation name you wish to edit.

3. Under the Bookings section, click the **Edit** icon next to the booking. These options are available if you have permissions.

   **Editing a Booking in the Bookings Section of My Events**

4. The **Room Request** window appears, where you can make changes to the booking.
5. If needed, you can edit the date and time of the booking under the **Date & Time** section.

6. Search for a new location under the Locations section in the left-hand column.

7. Click the **Add/Remove** link to select by Buildings or Views. Choose a Building or View. Click **Update Locations**.

8. In the Locations section, click **Search**.

   **NOTE:** Under the **Let Me Search for a Room** section in the left-hand column, you can select filters to apply to your search (e.g., Floors, Room Types, etc.).

9. Click the **Add (+)** icon to change the room in your booking.

10. Click **Update Booking** to save the changed location.
CHAPTER 26: Invite Attendees with Outlook

If your organization has deployed EMS for Microsoft Outlook, you can check attendees' availability as shown in Outlook. EMS automatically sends meeting invitations to attendees when you make a reservation in EMS Web App.

NOTE: Because EMS Web App is highly configurable, options that we show in the following procedure may not be present in your organization's implementation of EMS. Also, your organization may have customized some labels; for example, “group” may be “client,” “employee,” or “department”; "event" may be “Meeting,” and so on. Required fields are marked with a red asterisk (*).

1. Begin creating a reservation.

2. When you select attendees, the Create a Reservation window will show their availability in a calendar grid.
TIP: Depending on how your Administrator has configured EMS Web App templates, you might see different fields displayed, or you might not see some of these fields displayed at all.

3. Once you have completed the reservation and clicked **Create Reservation**, attendees will receive invitations based on the booking template you used. Changes you may make to the event will also trigger email updates.

*Example of an automatically generated email:*
CHAPTER 26: Invite Attendees with Outlook
CHAPTER 27: Notifications in the EMS Web App

The EMS Web App automatically sends out notifications based on the filters on the notification rule.

There are five types of notification rules:

1. Bookings
2. Service Orders
3. Anything on a VIP Event
4. New Web Users
5. User-Defined Fields

These are mostly sent out a predefined amount of days prior to a booking. They are triggered when a change occurs on a booking, service order, etc., within that range of days.

CONFIRMATIONS

Confirmations are either sent out automatically after a booking is made in EMS Web App, or manually from the EMS Desktop Client.
Confirmations contain the date/time/resources for the booking that was created. These usually go to end users so they know when their event is and if they owe any money.

**NOTIFICATIONS FOR EVENT CHANGES**

Your Administrator can automate alerts to be sent to you (or groups of which you are a member) when changes or additions have been made in EMS for bookings and reservations, service orders, room types, setup types, user accounts, and so on. When you create a reservation or booking that has these notifications turned on, users will receive these alerts without requiring additional effort from you. Review these notification settings during the process of creating or modifying events.

If your EMS Web App implementation uses the Integration with Exchange, you can handle notifications using Outlook.

**INTEGRATION TO MICROSOFT® EXCHANGE ENABLES YOU TO USE OUTLOOK®**

If your organization deploys our Integration to Microsoft® Exchange, you can view the availability of meeting rooms and attendees, and send Microsoft® Outlook® meeting invitations, all from within EMS Web App.
You must be licensed for EMS Desktop Client, EMS Web App, and Integration to Microsoft® Exchange in order to configure and use this capability. If you are unsure if your organization is licensed for Integration to Microsoft® Exchange, or if you would like to learn more about it, please contact your EMS Account Executive.
CHAPTER 28: Personalize Your Account

The My Account menu enables you to customize your user profile:

» Specify delegates. Delegates are web users who can act as you in EMS Web App and carry out actions on your behalf.

» Create your own, time-saving booking templates, which set default values (Start Time, End Time, and so on) for your most frequent types of reservations and room requests. These templates appear on your personal Home Page after you save them.

» Set a list of favorite rooms to streamline your search for available space.

The My Account menu is available in the upper right corner of EMS Web App next to your name once you log in.
The User Options page opens, showing tabs along the top where you can customize your user profile. The Account Details tab contains basic account information.
4. To further customize your EMS Web App account, refer to the following topics:

» [Create Delegate Accounts](#)
» [Set Default Values for Room Requests and Reservations](#)
» [Create a List of Favorite Rooms](#)
CHAPTER 30: Establish Delegates

You may wish to designate another EMS Web App user to make reservations and room requests and so forth on your behalf. You may need to do this, for example, to get someone else to handle your EMS work during your absence.

You begin by adding one or more EMS users to act as your delegate. Then they can log in and request to "Act As" you. You can keep track of their actions on your behalf, and any event invitations, cancellations, changes, room requests, service requests, and so on that they create on your behalf will appear to other EMS users as yours.

Concept: Delegates Act As You. Click for more…

A delegate is another authorized user who can act as you in EMS Web App and carry out actions on your behalf. To delegate users, first you add them to your account as delegates under My Account. Then they can use the Act As option and select your name.
ADD DELEGATES TO ACT AS YOU

1. Open the My Account option from the upper-right corner of EMS Web App.

2. Click the Delegates tab and add your delegates.
FOR THE EMS WEB APP USER WHO WILL ACT ON BEHALF OF ANOTHER

1. From the My Account dropdown, click Act As.

2. In the Act As popup, select which user you will be acting as and click OK to confirm.
Once activated, the user you are acting as will show in the upper-right corner of the EMS Web App, like this:
CHAPTER 31: Establish Booking Templates

You can personalize booking templates to streamline your process for requesting rooms and making reservations (depending on your permissions). These templates appear on your personal EMS Web App home page after you save them.

**TIP:** For more information about how booking templates work, see [Booking Templates, Requests, and Reservations](#).

1. In the upper-right corner of EMS Web App, click on the dropdown next to your name and select **My Account**.
2. From the My Account page, click **Personalization** and then click the **Templates** button.

3. You can change the default values for a template only if your administrator has set your permissions accordingly: select the template you wish to change. The lower section changes to show options for the selected template.
**TIP:** Essentially, your settings here automatically populate field values and filter search results when you make room requests. For example, setting a Start Time here will set a start time for any room request you make using this template, and setting a Setup Type will filter search results to only show rooms with that setup type.
TIP: If you select the *Override location and time zone settings when I search for available space* option under Locations, this means that whenever you book using this template, you can change the default location for this template during the booking process. For example, if your template Location was Denver and during booking you added Kansas, the template would be updated to Kansas going forward.

4. When you have finished making changes, click **Save Changes**.
CHAPTER 32: Set Favorite Rooms

Under My Account, you can create a list of favorite rooms. This streamlines the process of searching for available space when you request or reserve rooms.

1. Under the dropdown arrow next to your name in the upper-right corner of EMS Web App, click My Account.

The User Options page opens, showing tabs along the top where you can customize your user profile.

2. Click the Favorite Rooms tab to work with a list of your favorite rooms. Any rooms you have already saved as favorites are listed under Your Saved Favorite Rooms.
3. In the **Search** field, you can search for room you wish to favorite (your search string is not case-sensitive but characters must be in the correct order). Enter your search string. The dropdown updates to show results (taking into account your Location filters).
**TIP:** You can filter your search results by clicking *Filter by Location*, which presents a list of locations by Building or view. Select the locations filters you wish to apply (or search by keyword), and then click *Update Locations*. This filters the results of your keyword search on the Add New Favorite Room dialog (above). Your filter settings are saved, and you will have to go back in and remove them if you wish to expand search results beyond these locations.
4. To add a favorite to the list, select it from the search results. The room is added to **Your Saved Favorite Rooms**. When you book a room in EMS Web App, you can now choose more quickly from your Favorites list.
**TIP:** Once you have established favorites, EMS Web App uses these to filter your search results when you search for available space during the reservation process.

To remove a favorite, click X next to the room in **Your Saved Favorite Rooms**.
CHAPTER 33: Mobile Web App

EMS Web App is available both in a desktop client version and in a mobile version. If you access EMS Web App from a mobile device, you are redirected to the mobile version of EMS Web App.

» Use the EMS Web App on Mobile Devices

» EMS Mobile App Versus EMS Mobile Web App: What Is the Difference?
CHAPTER 34: Use the EMS Web App on Mobile Devices

If you access EMS Web App from a mobile device such as a tablet or smartphone, the application will look slightly different because of the limitations of the device. In general, drop-downs and menu bars will be reduced or abbreviated, and you will need to click to expand some regions and scroll to view some information.

*Examples of the EMS Web App on a Mobile Device*
CHAPTER 34: Use the EMS Web App on Mobile Devices

**Home Screen**

**Mobile Menu**

![Home Screen](image1)

![Mobile Menu](image2)

**Book**

**My Bookings**

**Search**

**Mountain Time [MT]**

<table>
<thead>
<tr>
<th>Sun</th>
<th>Mon</th>
<th>Tue</th>
<th>Wed</th>
<th>Thu</th>
<th>Fri</th>
<th>Sat</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
<td>12</td>
<td>13</td>
<td>14</td>
</tr>
</tbody>
</table>

- 2:30 PM - 3:00 PM
  - Test meeting
- 3:00 PM - 5:00 PM
  - Test meeting with Wendy

**Create a Reservation**

**Browse**

**Events**

**Locations**

**People**

**Conference Room**

**Demo Room 01**
QUICK TASKS

Click on **Home** at any time to return to the Mobile EMS Web App Home page.

Click on an **event name** to see details.
Click on **New Booking** to begin making a new booking.

## ICONS TO REMEMBER

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑️</td>
<td>Main menu for navigating EMS Web App.</td>
</tr>
<tr>
<td>✏️</td>
<td>Click to change information.</td>
</tr>
<tr>
<td>🎨</td>
<td>Click to see a calendar view.</td>
</tr>
<tr>
<td>✨</td>
<td>Click to add or remove an item.</td>
</tr>
</tbody>
</table>

## WHAT IS THE DIFFERENCE?

In general, the mobile display focuses on "doing" rather than "viewing." For example, you can easily book a room or check in to a meeting, but exploring reservations with hundreds of intricate bookings or locations with numerous rooms and setups might be best done using a non-mobile browser, due to the volume of information you may want to see in one window.
**TIP:** To see "My Bookings" from anywhere in the mobile version of EMS Web App, simply click **Home**.

**FUNCTIONAL LIMITATIONS**

The following features of the EMS Web App on mobile devices are different than on a standard computer web browser and have limited functionality due to the parameters of mobile browsers and display area and data limitations:

- Available rooms display in a list view; schedule and Floor Plan views are not available.
- The Services tab is not available.
- You cannot book multiple rooms in Microsoft Outlook.
- The main menu is always hidden and accessible by clicking the Menu icon in the upper-left corner.
- You can only book one room per booking.
- The home screen only contains bookings and ability to search, and does not show the "Site Home" tab.
- When creating a new reservation, you type the name of the desired room rather than searching by keyword.
- To edit reservations on your My Events page, you tap the Edit icon next to the reservation.
To see a room's schedule from the Browse Events page, click the grid icon next to the room name.

**TIP:** EMS also produces a mobile application for use on devices like smartphones.

See Also: [EMS Mobile App Versus EMS Mobile Web App: What Is the Difference?](#)

Although their names are similar and they share the same databases, these products have very different applications.

EMS MOBILE APP = EMS APPLICATION FOR MOBILE DEVICES

This is a separate software application EMS produces specifically to run on mobile devices, such as smartphones.

FEATURES OF EMS MOBILE APP (WHICH ARE NOT IN EMS WEB APP)

- Ultra-compact display designed for smartphones
- Two factor authentication method
- QR Code functionality
EMS MOBILE WEB APP = EMS WEB APP ON A MOBILE BROWSER

This is the EMS Web App as it displays when running on a web browser on a mobile device, such as a tablet.

FEATURES OF EMS WEB APP (WHICH ARE NOT IN EMS MOBILE APP)

» Browse Events
» Browse People
» Act As (delegation feature)
» Edit Account Details
» Edit Delegates
» Edit Everyday User Process templates
CHAPTER 36: Learn About EMS Web App

» How do I search for available space? What if I only want to make a reservation if a specific room is available?

Use the BROWSE options from the main menu. For more guidance, see Browse Events, Locations, and People.

» Why can't I make a reservation?

Several settings control your capabilities as a user. For a deeper understanding, see Create a Reservation in the EMS Web App.

» Why are some options not available to me?

This is probably because of settings controlled by your Administrator. For more detail about these settings, see Understand Everyday User Templates.

» Can I let someone else make reservations on my behalf?

If enabled by your Administrator, you can delegate to other users. They will then opt to act as you from their My Account menu.
How do I check if a room I want is available? How do I check a person's availability when making a reservation?

Start at the My Home page and Browse Events, Locations, and People. If you have Outlook, you can view people’s availability in a calendar view during the booking process.

How do I add Services to a booking?

You can add them during the initial booking process or by editing it later. Services, Resources, and Categories interact as part of the booking details for an event.

EMS WEB APP FAQS

» Booking Templates, Requests, and Reservations
» Delegates Act as You
» My Events vs. Browse Events
» Notifications Automatically Alert People to Changes in EMS
» EMS for Outlook® (Optional Capability)
» Integration with Exchange Enables You to Use Outlook®
» Reservations, Bookings, and Booking Details
» Troubleshoot Internal Server Error When Viewing My Events in EMS Web App
» Understand Everyday User Templates
CHAPTER 37: Booking Templates, Requests, and Reservations

BOOKING TEMPLATES

Your Administrator creates different Booking Templates for different purposes. For example, your Administrator could make one template for individual workspaces, another template for meeting rooms without services like catering, and yet another template for meetings with services.

For each template, your Administrator can enable some fields and disable others. For example, your Administrator could set up a "meeting room with services" template that requires you to enter a purchase order number to pay for the services.

You can set up default values of the templates that are available to you so that you can more quickly make your reservations. For example, if you book a workspace every day from 8:30 am to 4:30 pm, you can set up these times as default values so that you don't have to enter them every time. (You can override them anytime you need to.)
To set up default values for your templates, go to My Account and then to the Personalization tab.

REQUESTS VS. RESERVATIONS

Depending on your permissions, you may Request a Room or Make a Reservation. Room requests require approval from a supervisor and are visible to other users so they know the space has been tentatively booked. The EMS Web App behaves differently for each type of user, showing fewer options (and usually, less information) for those who can only request rooms.
CHAPTER 38: Delegates Act as You

DELEGATE

A delegate is another authorized user who can act as you in EMS Web App and carry out actions on your behalf. To delegate users, first you add them to your account as delegates under My Account. Then they can use the Act As option and select your name.

See Establish Delegates for instructions on adding delegates to act as you.
Important: If you logging in and out as a guest, you will only have permissions to request reservations, therefore the MY EVENTS option will not be available.

WHAT IS THE DIFFERENCE BETWEEN MY EVENTS AND BROWSE EVENTS?

These two menu options on the left side of the EMS Web App enable you to accomplish different tasks:

MY EVENTS = RESERVATION MANAGEMENT

Clicking My Events displays all reservations and bookings linked to your profile and enables you to manage your reservations, change details, and create new bookings.
BROWSE EVENTS = EXPLORE THE SCHEDULE

Clicking **Browse > Events** provides a view of events on the calendar for you and all users in your organization. This view helps you locate available time slots for space before requesting or making a reservation.
CHAPTER 40: Notifications Automatically Alert People to Changes in EMS

In EMS, changing events can automatically notify users. Your Administrator can automate alerts to be sent to you (or groups of which you are a member) when changes or additions have been made in EMS for bookings and reservations, service orders, room types, setup types, user accounts, and so on. When you create a reservation or booking that has these notifications turned on, users will receive these alerts without requiring additional effort from you. Be sure to review these notification settings during the process of creating or modifying events.

If your EMS Web App implementation uses the Integration with Exchange, you can handle notifications using Outlook®.
CHAPTER 41: EMS for Outlook® (Optional Capability)

EMS for Outlook® is an optional (extra cost) purchase. If your organization has purchased it, then you will see the EMS plugin icon in your Outlook application. You will also see additional features and functionality in EMS. Furthermore, anywhere that you see people or groups in EMS, you will have access to everyone in your organization's email database (which is stored in Exchange Server). This means that you can see people's availability (Out of Office, Busy, In a Meeting, etc.), send them email invitations or notices, and add EMS events to your Outlook calendar.
CHAPTER 42: Integration with Exchange Enables You to Use Outlook®

If your organization deploys our Integration to Microsoft® Exchange, you can view the availability of meeting rooms and attendees and send Microsoft® Outlook® meeting invitations, all from within EMS Web App.

You must be licensed for EMS Desktop Client, EMS Web App, and Integration to Microsoft® Exchange to configure and use this capability. If you are unsure if your organization is licensed for Integration to Microsoft® Exchange, or if you would like to learn more about it, please contact your EMS Account Executive.

See Also: Integration to Microsoft® Exchange Guide
CHAPTER 43: Reservations, Bookings, and Booking Details

The two essential EMS components for meeting and event scheduling are reservations and bookings. To use the EMS Web Client efficiently and effectively, you must understand the structure of a reservation in EMS, the concept of an event timeline for a reservation booking, and how to make a reservation. This section covers the following topics:

» Reservation Structure
» Event Timeline
» Make a Reservation Using the Reservation Wizard
» View and Edit Reservations in the Reservation Book

RESERVATION STRUCTURE

An event in EMS Desktop Client is comprised of the following:

1. A Reservation
2. One or more Bookings
3. Booking details
These three components exist in a hierarchy—a reservation contains one or more bookings, and each booking can have one or more details associated with it.

**RESERVATIONS**

A reservation is the who and the what of an event. For example, Group X (the who) can reserve some space for an Event Y (the what). A booking is the where and the when of an event. For example, Group X can schedule the conference room (the where) for a staff meeting on the second Monday in January (the when). Group X now has a single reservation with a single booking in EMS. If, however, Group X schedules the conference room (the where) for a staff meeting on the second Monday of each month for a calendar year (the when), then Group X now has a single reservation with twelve bookings in EMS.

**BOOKING DETAILS**

A booking can have one or more booking details associated with it. Booking details are the resources or services that are needed for an event, the notes for the event, the activities for the event, the room charges for the event, or any combination of these. For example, for Group X’s staff meeting, the resources could include the requested catering (coffee service, bagels and muffins, and so on) and the A/V equipment (a projector, a speaker’s podium, and so on).
EVENT TIMELINE

The following time designators are used for an event in EMS Desktop Client:

» **Event Time**: The time period during which the event actually takes place.
» **Setup/Teardown Hours**: The hours, or fractions of hours, that you add to the event time to allow staff to prepare a room for the event or to clean up after the event.
» **Reserved Time**: The total time for which the space (the where) is reserved. This time is the event time plus the setup/teardown time.

<table>
<thead>
<tr>
<th>VARIABLE</th>
<th>TIME</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserved Start Time</td>
<td>8:00 a.m.</td>
</tr>
<tr>
<td>Setup Hours</td>
<td>1 hour</td>
</tr>
<tr>
<td>Event Start Time</td>
<td>9:00 a.m.</td>
</tr>
<tr>
<td>Event End Time</td>
<td>4:00 p.m.</td>
</tr>
<tr>
<td>Teardown Hours</td>
<td>1.5 hours</td>
</tr>
<tr>
<td>Reserved End Time</td>
<td>5:30 p.m.</td>
</tr>
<tr>
<td>Reserved Time</td>
<td>9.5 hours</td>
</tr>
</tbody>
</table>
MAKE A RESERVATION USING THE RESERVATION WIZARD

The Reservation Wizard allows you to check for available space and make a reservation for an event. You can search for rooms that are available for a particular time on one day (a simple reservation with one booking) or on multiple days (a series reservation with multiple bookings). You can also create a series reservation by selecting one date and time, but multiple rooms. To make a reservation using the wizard, you must do the following:

» Specify the Event Date and Time Information
» Specify the Event Time and Status
» Select the Event Location
» Specify the Event Information

NOTE: The following procedure describes how to make a reservation by selecting values for the required and optional fields.

» If your EMS administrator has configured reservation wizard templates, then a Reservation Wizard Template dropdown list is displayed at the top of the Reservation Wizard. You can facilitate the making of a reservation in the Reservation Wizard by selecting the appropriate template.
from the list, which automatically sets the default values for many of the fields in the Reservation Wizard.

» If your job entails making multiple reservations that require the same information, and you are not using reservation wizard templates, then you can set your own default values for many of the fields in the Reservation Wizard.

SPECIFY THE EVENT DATE AND TIME INFORMATION

1. On the EMS Desktop Client toolbar, click the **Wizard** icon. The Reservation Wizard page opens.

2. If needed, use the scroll features on the top of the **Calendar** to open the calendar for a different month (< or >), or click a month at the top of the calendar to open a dropdown list from which you can select a different month. You can also click a year at the top of the calendar to open a dropdown list from which you can select a different year.

3. If the event dates do not follow a pattern, use one or more of the following options for entering a date:
» Click on the dates on the calendar that the event is to take place.

» To select all five weekdays in a week, click in the blank space that is to the left of the week.

» To select all seven days in a week, double-click in the blank space that is to the left of the week.

» To select every occurrence of a specific day of the week for the displayed month (for example, all Sundays in June, 2017), click the heading (S, M, T, and so on) for the day.

» To select every occurrence of a specific day of the week that is currently displayed onscreen (regardless if the day falls within the same month), double-click the heading (S, M, T, and so on) for the day.

4. If the event dates do follow a pattern, (for example, the third Friday of every month), click **Date Pattern** at the bottom of the Calendar to open the Date Pattern dialog box and enter your event date information. As you specify the event dates, the following occurs:

» The **Selected Dates** tab at the top of the Calendar is automatically updated with the selected dates.

» If your EMS administrator has configured any of the dates as a holiday or closed, then holiday dates are displayed in green on the **Calendar** tab and closed dates are displayed in red. For any date, after you select the date on the
Calendar tab, you can:

» Toggle between the Calendar tab and the Selected Date tab. Open the Selected Dates tab, select the date, and then click Go To Date.

» You can remove a date from the list of selected dates by opening the Selected Dates tab, selecting the date (or CTRL-click to select multiple dates), and clicking Remove.

» For dates that are configured as a holiday or as closed, you can:

» Place your cursor on a holiday date to open a tooltip that shows the name of the holiday.

» View information about the date from the Selected Dates tab. Open the Selected Dates tab, scroll to the date, and then click Holidays to open a Holidays dialog box that displays information about the holiday.

» Place your cursor on a closed date to open a message that states that you cannot select the date because the date is closed.

5. Continue to specify the event time and status.
SPECIFY THE EVENT TIME AND STATUS

1. Specify the start time and end time for the event in one of two ways:
   - Click the Time Picker icon to open a dropdown list from which you can select a time for each field.
   - Under the Time section, manually enter the start and end times from the dropdowns. If applicable, select the appropriate Time Zone for the event.

2. Specify the Setup and Teardown times in one of two ways:
   - To use the default setup and teardown times that your EMS administrator has assigned to the rooms in your system, leave the Use Default checkbox selected.
   - Override the default setup/teardown times by clearing the Use Default checkbox, and selecting Minutes or Hours, and entering your own setup and teardown times.

3. Indicate the status for the event.

4. Continue to select the event location.

SELECT THE EVENT LOCATION

You have three options for selecting the event location, which are indicated on the first page of the Reservation Wizard:
1. **Standard**: Use this option to display a list of all the available rooms that meet all the requested dates.

2. **Best Fit**: Use this option if no one room can meet all the requested dates. The system lists rooms along with the number of bookings for which you can reserve the room. You can piece together the entire reservation using Best Fit, or just part of it.

3. **Specific Room**: Use this option to confirm the availability and reserve of one specific room for the scheduled event.

### I. TO SEARCH FOR A STANDARD ROOM:

1. Select **Standard**.

2. Choose one of the following for room specifications:
   
   » **Type** is the class or category of the room, for example a meeting room, a workspace, and so on. Leave Type set to the default of (all) to search for all pre-configured room types or select a specific room type from the Type dropdown list.

   » **Floor** is optional information when you are searching for a room. Leave Floor set to the default value of (all) to search for all pre-configured floors or select the floor from the Floor dropdown list.

   » **Setup Type** is the physical layout or arrangement of a room, for example, rounds of 6 or theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured setup types or select the setup type from the Setup Type dropdown list.
**Setup Count** is the anticipated attendance for the event. If you selected a specific setup type, then you must enter the setup count.

3. To select a **Feature**, open the Features tab, select the Feature, or CTRL-click to select the multiple features that the room must have.

4. Click **Next**. Up to two tabs are displayed:

   - The **Available** tab, which is the active tab and is always displayed, lists all the rooms that meet all your event criteria.
     - If you have elected to show the Available All Day Indicator, the rooms that are available all day are marked with an asterisk (*).
     - By default, the available rooms are sorted alphabetically by room code. If your EMS administrator has configured the rooms for your EMS implementation with a book sequence, then under Options, select Sort Rooms by Book Sequence to sort the rooms from lowest to highest book sequence. (If two rooms have the same sequence, then the rooms are sorted alphabetically by name within the sequence.)

   - The **Conflicts** tab is displayed only if there are rooms that are not available for the requested dates/times. Optionally, you can open the Conflicts tab to view the list of rooms that were not available for scheduling as well as list of the events that are scheduled for each room.
5. Select the room, or CTRL-click to select the multiple rooms that you are scheduling for the event.
6. Click **Room Info** to open the Room Info dialog box and view information about the room properties, notes, Room URL, Building URL, setup type and capacity, and features. Click **Close**.
7. Click **Building Hours** to open the Building Hours dialog box which displays the hours that the selected room/building is open on the reserved date. Click **Close**.
8. Click the **Move** button (>) to move the rooms to the Selected list.
9. Click **Next** to specify the **event Information**.

**II. TO SEARCH FOR A BEST FIT ROOM:**

1. Select **Best Fit**.
2. Leave **Building** set to the default value of (all), or select a specific Building, Area, or View in which to search for a best fit room.
3. Choose one of the following for room specifications:
   - **Type** is the class or category of the room, for example a meeting room, a workspace, and so on. Leave Type set to the default of (all) to search for all pre-configured room types or select a specific room type from the Type dropdown list.
   - **Floor** is optional information when you are searching for a room. Leave Floor set to the default value of (all) to search for all pre-configured floors or select the floor from the Floor dropdown list.
**Setup Type** is the physical layout or arrangement of a room, for example, rounds of 6 or theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured setup types or select the setup type from the Setup Type dropdown list.

**Setup Count** is the anticipated attendance for the event. If you selected a specific setup type, then you must enter the setup count.

4. Open the **Features** tab, and then select the feature, or CTRL-click to select the multiple features that the room must have.

5. Click **Next**. Up to two tabs are displayed:
   - **The Available tab**, which is the active tab and is always displayed, has two lists. The list in the left pane is a list of all the rooms that meet some or all of your event criteria. The list in the right pane is a list of all the event dates that must be fulfilled.
   - **The Conflicts tab** is displayed only if there are rooms that are not available for the requested dates. Optionally, you can open the Conflicts tab to view the list of rooms that were not available for scheduling for the event as well as list of the events that are scheduled for each room.

6. Choose one or both of the following:
   - Click **Room Info** to open the Room Info dialog box and view information about the room properties, notes, Room URL, Building URL, setup type and capacity,
and features. Click **Close**.

» Click **Building Hours** to open the Building Hours dialog box which displays the hours that the selected room/building is open on the reserved date.

Click **Close**.

7. Choose one of the following:

» If one is available, select the single room that is available for all the requested dates, and then click the Move button (>) to move the room to the **Event Dates** list.

» If a single room is not available, select a room that is available for some of your requested dates, and then click the Move button (>) to move the room to the **Event Dates** list. Repeat this step as needed to fulfill all the event dates.

8. Click **Next** to **specify the event information**.

**III. TO SEARCH FOR A SPECIFIC ROOM:**

You can use the **Specific Room** search to book a standard EMS room or a room or area that is not managed in EMS. An override room, or “override description,” is used to book an event in a space that has not been configured in your EMS system. For example, your EMS administrator might have configured an override room named “Other Area” in the Engineering building. To book an event in Dr. Wilson’s office, which is a room that is not defined in EMS, in the Engineering building, you can select the “Other Area” room and specify “Dr.

```
Wilson's Office” for the location. EMS does not track availability for events booked in override rooms; however, EMS reports on events that are scheduled in an override room just like any other event scheduled for any other room.

1. Select **Specific Room**. The Room Selector dialog box opens. By default, (all) buildings is selected.

2. Do one of the following:
   >> To select a room from a list of all rooms in all available buildings:
      >> Leave (all) selected on the Buildings dropdown list.
      >> Click the **Add** icon next to a room to select it.
      >> If the room is configured as an override room, continue to the next step.

   >> To select a room from a list of rooms in a specific building, area, or view:
      >> Select a specific building, area, or view.
      >> Click the **Add** icon next to a room to select it.
      >> If the room is configured as an override room, continue to the next step:
         >> In the **Location** field, enter the location of the override room, and then click **Next**. Two results are possible:
            >> If the event is scheduled for a single date and the room is available, then continue to the next step.
» In all other cases, (for example, the event is scheduled for a single date but the room is not available or it is a multiple date event), the Available tab opens. This tab lists all the event dates for which the specific room is available.

3. Optionally, before you move a date to the Selected list, click Building Hours to open the Building Hours dialog box which displays the hours that the selected room/building is open on the selected date.

4. Optionally, before you move a date to the Selected list, do one or both of the following:
   » Click Room Info to open the Room Info dialog box and view information about the room properties, setup type, features, and pricing.
   » Click Building Hours to open the Building Hours dialog box which displays the hours that the selected room/building is open on the reserved date.

5. Do one of the following:
   » If the specific room is available for all the event dates, then click the Move All button (>>) to schedule the room for all the event dates.
   » If the specific room is not available, try another approach, such as reserving a different specific room, or try using the Standard or Best Fit search method.
6. Click **Next**.

SPECIFY THE EVENT INFORMATION

After you select an event location(s), you must specify other information for the event.

1. Enter the event information.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event</td>
<td></td>
</tr>
<tr>
<td>Event Name</td>
<td>A name or description for the event.</td>
</tr>
<tr>
<td>Event Type</td>
<td>The classification for the event.</td>
</tr>
<tr>
<td>VIP Event</td>
<td>Select this option to mark the event as a Very Important event.</td>
</tr>
<tr>
<td>Source</td>
<td>The reservation source.</td>
</tr>
<tr>
<td>Video Conference</td>
<td>Select this option for a video conference event.</td>
</tr>
</tbody>
</table>

**Employee/Contact**
### FIELD | DESCRIPTION
--- | ---
Employee | Click the Search icon to open an Employees dialog box in which you search for and select a specific employee from a list all employees that are available in your system for hosting/sponsoring an event.

  » To search a list of all employees, leave the Find field in the Lookup dialog box blank, and then click the Search icon.

  » To search for a specific employee, enter a search string in the Find field, and then click Search icon. Your search is limited to the exact order of the characters in the string, but the string can appear anywhere in the search results and it is not case-sensitive. For example, the search string sim returns Paske, Simon and Simington, Chance.

  » To select an employee, click the Add icon next to the employee.

  » If the employee that you want to select for the reservation is not available on the pre-configured list, then you can click the Employee icon to open the Employee dialog box and add the employee.

**NOTE:** After you select an employee, you can click Employee Info at the bottom of the Reservation Wizard page to open a dialog box that displays the properties for the employee, any user-defined fields for the employee, and any comments that are associated with the employee.

1st Contact | When you select a group, if a default contact has been defined for the group, then this field is automatically populated with the name of the contact; otherwise, the field is blank. You have several options for defining the 1st Contact for a reservation:
If the field is blank, but contacts have been configured for the group, you can select a contact from the pre-configured list.

If the field is populated with a default value, but other contacts have been configured for the group, you can select a different contact from the pre-configured list.

If you want to create a temporary contact just for this event, then select (temporary contact), and in the Temp Contact field, enter the name for the temporary contact.

**NOTE:** If a default contact has been configured for the employee, then any modifications that you make for the contact apply to this reservation only. The next time you or anyone else creates a reservation for this group, the 1st Contact field is again automatically populated with the name of the default contact.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>2nd Contact</td>
<td>Define if necessary for the event.</td>
</tr>
<tr>
<td>Temp</td>
<td></td>
</tr>
<tr>
<td>Contact</td>
<td></td>
</tr>
<tr>
<td>Phone</td>
<td>One more of these fields might be automatically populated depending on how a selected contact has been configured. You can manually edit these values if needed.</td>
</tr>
<tr>
<td>Fax</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td></td>
</tr>
</tbody>
</table>
**NOTE:** The Phone and Fax fields have a dropdown list available on which you can select a different value (Cellular, Fax, Office, Other, Primary) for the field label, or you can enter a user-defined value. To enter a user-defined value, double-click the current field label to select it, and then enter the user-defined value over the selected label.

**NOTE:** If default values have been configured for a selected contact, then any modifications that you make apply to this reservation only. The next time you or anyone else creates a reservation for the same contact, these fields are again automatically populated with the default information.

**Room Setup Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup Type</td>
<td>If you selected a specific value for the setup type when searching for an event location, this value is carried forward to this field; otherwise, the field is blank. You can select a setup type for this field, or if the field is already populated, you can select a different setup type.</td>
</tr>
<tr>
<td>Setup Count</td>
<td>If you entered a specific value for the setup type when searching for an event location, this value is carried forward to this field; otherwise, the field is blank. You can enter a value in this field, or if the field is pop-</td>
</tr>
</tbody>
</table>
### Billing Tab

Note: Depending on the group that you select, one or more of these fields might be automatically populated with default values. You can edit these default values but any modifications that you make apply to this reservation only. The next time you or anyone else creates a reservation for the same group, these fields are again automatically populated with the default billing information.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pricing Plan</td>
<td>Indicates what type of pricing is to be used for the event.</td>
</tr>
<tr>
<td>Cost Center</td>
<td>The internal alphanumeric billing code that is associated with the group. You can manually enter a value in this field, or if a master list of billing reference numbers has been configured for the group, you can click the Search icon to open a Cost Center Numbers dialog box, and select the appropriate value from this list.</td>
</tr>
</tbody>
</table>

**NOTE:** To search for a specific cost center number, enter a search string in the Find field, and then click the Search icon. The string is not case-sensitive, but your search is limited to the exact order of characters in the string and it must begin with the information for which you are searching. For example, a string of `co` returns `CO-123`, but *not* `123-CO`.

| Sales Category | How the group is sorted for purposes of tracking sales figures (e.g., local, regional, national, etc.). |
## CHAPTER 43: Reservations, Bookings, and Booking Details

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment Type</td>
<td>Indicates how the group paid for the event (cash, check, charged, and so on).</td>
</tr>
<tr>
<td>Dept. Code/PO Number</td>
<td>The internal alphanumeric purchase order number that is associated with the group. You can manually enter a value in this field, or if a master list of purchase order numbers has been configured for the group, you can click the Search icon to open a Purchase Order Numbers dialog box, and select the appropriate value from this list.</td>
</tr>
</tbody>
</table>

**NOTE:** To search for a specific purchase number, enter a search string in the Find field, and then click the Search icon. The string is not case sensitive, but your search is limited to the exact order of characters in the string and it must begin with the information for which you are searching. For example, a string of **co** returns **CO-123**, but **not 123-CO**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salesperson</td>
<td>The user who “sold” the event.</td>
</tr>
<tr>
<td>Other Tab</td>
<td></td>
</tr>
<tr>
<td>Event Coordinator</td>
<td>The Event Coordinator assigned to the event.</td>
</tr>
<tr>
<td>Estimated Event</td>
<td>The estimated number of people who are expected to attend the event.</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Attendance</td>
<td></td>
</tr>
<tr>
<td>Calendar</td>
<td>Dropdown list of all the available formats for printing this event on the Event Calendar and Event Schedule reports.</td>
</tr>
<tr>
<td>Style</td>
<td></td>
</tr>
<tr>
<td>URL</td>
<td>The event URL.</td>
</tr>
</tbody>
</table>

**Virtual Tab**

- Everyday User
  - To specify the everyday users who can view/manage this reservation in VEMS, click the Search icon to open the Everyday Users search dialog box and search from a list of registered everyday users.
  - You can search by **User Name** or **Email Address**
  - To search a list of all available everyday users, leave the Find field in the Lookup dialog box blank, and then click the Search icon
  - To search for a specific everyday user, enter a search string in the Find field, and then click Search icon

**NOTE**: The string is not case-sensitive, but your search is limited to the exact order of characters in the string and it must begin with the information for which you are searching. For example, if searching
<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>by Email Address, a search string of bb returns <a href="mailto:bbosworth@dea.com">bbosworth@dea.com</a> but not <a href="mailto:dbobbett@dea.com">dbobbett@dea.com</a></td>
<td></td>
</tr>
</tbody>
</table>

» To select an everyday user, click the Add icon next to the user.

**NOTE:** To return this field to the (no change) value at any time, click Reset.

<table>
<thead>
<tr>
<th>Process Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>The process template that defines the functions that are available for the selected everyday user.</td>
</tr>
</tbody>
</table>

**NOTE:** An Everyday User might be assigned to more than one process template, so make sure to select the template that is applicable for this reservation.
User-defined fields are additional fields that store custom data for a reservation. Your EMS administrator configures the types of fields that are available as well as the allowed values for these fields.

- To enter or modify a value for a field, select the field, and then click Set Value.
- To clear a value for a field, select the field, and then click Clear Value.

Note: If a user-defined field is not required here, you can always supply a value for it at a later date in the Navigator.

2. Click Finish. Two results are possible:
   a. If you did not enter information into required fields, then these fields are outlined in red. You must enter values into these fields and then click Finish again to open the Navigator page.
   b. The Navigator opens. The reservation information is displayed in the Navigator. You use the Navigator to add booking details and to make any needed modifications to the reservation and its bookings.

**WARNING:** A reservation is not complete and rooms are not removed from the Available list until you click Finish. Although unlikely, it is possible for
another user to select and reserve a room during the time period after you have selected the room but before you have finalized the reservation. If this occurs, after you click Finish, a message opens stating that your reservation conflicts with an existing reservation.

VIEW AND EDIT RESERVATIONS IN THE RESERVATION BOOK

The Reservation Book provides a graphical view of all the confirmed reservations (the reserved time as well as the room for which the reservation is scheduled) for your organization. (Canceled bookings are not shown.) You use the Reservation Book to view information for a reservation, to edit an existing reservation, and to make a new reservation. In addition, when the Reservation Book first opens, before you edit or make a reservation, you can change the Reservation Book view so that it better suits your working needs.

This section will provide information on the following topics:

» Open the Reservation Book
» Change the Reservation Book Display
» View Reservation Information
OPEN THE RESERVATION BOOK

1. From the toolbar, click the **Book** icon. The first time that you open the Reservation Book for your EMS implementation, by default, the Filter dialog box opens on top of a blank Reservation Book. You can leave the room filtering criteria set to their default values, or you can select different values as needed, and then click **OK**. All reservations that meet the filtering criteria and that are scheduled for the current day’s date are displayed in the book in the Daily view.

> **TIP:** You might need to use the book’s scroll features to scroll through all the reservations that are scheduled for the current day’s date.

> If an event is scheduled for a room that is a component of a combination room, then the reservation text is displayed in black. A duplicate reservation is also shown for the combination room; however, the reservation text is displayed in gray to indicate that a component of the combination room is currently booked for the indicated time and therefore, the combination room is not available.

> Conversely, if an event is scheduled for a combination room, then the reservation text for the combination room is displayed in black and the reservation
text for each component is displayed in gray. This reversed color coding indicates that the component room is currently booked for the selected time and that none of the components is available.

**TIP:** The Reservation Book has the following appearance:

- Minimum and maximum capacities are displayed next to room descriptions
- The current time is shown by a vertical line in the grid, called the Current Time Indicator
- If building hours have been configured for a building, then this information is displayed for the building

The reservations are displayed with three components:

- A left bar that indicates the setup time
- A middle bar that indicates, by default, the event name
- A right bar that indicates the teardown time

**CHANGE THE RESERVATION BOOK DISPLAY**

1. On the EMS Web Client toolbar, click the **Book** icon. The Reservation Book opens in the Daily view.
2. You can change the Reservation Book display in the following ways:
   - Change the list of rooms that are displayed in the Reservation Book based on room properties.
   - Change the list of rooms that are displayed in the Reservation Book based on a specific room(s).
   - Change the Reservation Book view.
   - Change multiple display options for a reservation.
   - Select which items to include in the tooltip that opens when you place the cursor over an event in the Reservation Book.
   - Change the display date using the calendar.
   - Change the display date using the Reservation Book scroll features.

3. To change the list of rooms based on room properties:
   a. Click Filter if the Filter dialog box is not already open.
   b. Select Room Properties and customize one or more of the following:
      - Leave the Building dropdown list set to the default value of (all) buildings, or select a specific building, area, or view.
      - Select a specific floor.
      - Select a specific room type.
      - Select Capacity and then enter a capacity.
      - Select Academic to limit the search to academic rooms.
      - Select a Room Availability option.
c. Click **OK**. The Filter Rooms dialog box closes. The room display in the Reservation Book is changed accordingly.

4. To change the list of rooms that are displayed in the Reservation Book based on a specific room or rooms:
   a. If the Filter Rooms dialog box is not already open, then above the Rooms list, click **Filter** to open the dialog box and select **Specific Room**.
   b. Select the room, or CTRL-click to select multiple rooms on the Available list.
   c. Click the **Move (>)** button to move the selected rooms to the Selected list.
      The Reservation Book is updated to show bookings only for the selected rooms.

5. To change the Reservation Book view, from the View dropdown list, select Daily, Weekly, or Monthly.

6. To change multiple **display options** for a reservation:
   a. Click **Options** (upper right hand corner of Reservation Book) to open the **Book Options** dialog box (the General tab is the active tab).
   b. Change multiple display options not only for the Reservation Book, but also a reservation in the book.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>The daily start time for the Reservation Book display.</td>
</tr>
<tr>
<td>Hour</td>
<td></td>
</tr>
<tr>
<td>OPTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display</td>
<td>The information that is displayed in the middle bar for a reservation.</td>
</tr>
<tr>
<td>Time Display Interval</td>
<td>Changes the granularity of the time display interval.</td>
</tr>
<tr>
<td>Maximum Number of Rooms</td>
<td>The maximum number of rooms to display in the Reservation Book.</td>
</tr>
<tr>
<td>Booking Colors Based On</td>
<td>The color of the bookings in the reservation. Select one: Status, Event Type, or Check-in Status (for EMS Workplace only.)</td>
</tr>
<tr>
<td>Rooms Without Bookings</td>
<td>Whether to highlight rooms without bookings and if so, the highlight color. If both Highlight Rooms and Booked Space Status Only are selected, then only those rooms that do not have a Booked Space status are highlighted.</td>
</tr>
<tr>
<td>Room Display</td>
<td>Display the room code or the room name for a reservation.</td>
</tr>
<tr>
<td>Building Display</td>
<td>Display the building code or the building name for a reservation.</td>
</tr>
<tr>
<td>Go To</td>
<td>If selected, the Reservation Book opens to the current day's date; otherwise, it opens to the last date viewed.</td>
</tr>
<tr>
<td>OPTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Today on Startup</td>
<td></td>
</tr>
<tr>
<td>Always Prompt for Room Filter on Startup</td>
<td>If Show ‘(all)’ in Building List is also selected, then when you open the Reservation Book, the Filter dialog box opens on top of the Reservation Book. You can select different options on this dialog box to display only specific reservations in the book, for example, bookings only for selected rooms. If you do not select any options on this dialog box, but instead simply close it, then all reservations for all rooms in all buildings are displayed in the book.</td>
</tr>
<tr>
<td>Hide Current Time Indicator</td>
<td>Show or hide the vertical bar that indicates the current time for current day.</td>
</tr>
<tr>
<td>Show ‘(all)’ in Building List</td>
<td>Note: The Current Time indicator is displayed only if the view is the Daily or Weekly view and the view includes the current day's date.</td>
</tr>
</tbody>
</table>

Show the “all” option on the Building dropdown list; otherwise, a user must select a specific building. If this option is selected in conjunction with Always Prompt for Room Filter on Startup, then when you open the Reservation Book, then the Filter dialog box always opens on top of the Reservation Book. If you are setting your Reservation Book options, and you do not want to the Filter dialog box to open on top of the Reservation Book when you open the book, then do the following:

- Clear Always Prompt for Room Filter on Startup.
- Clear Show (‘all’) in Building List.
- On the Building dropdown list in the Reservation Book, select any building, area, or view.
### NOTE:
The building, area, or view that you select is not important. This last step just clears the “all” building option from the Reservation Book cache and ensures that the Filter dialog box does not open on top of the Reservation Book. Going forward, you can always select all buildings, or any specific building, area, or view as needed when you are working in the Reservation Book.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show</strong></td>
<td>Show the minimum and maximum capacities next to the room description.</td>
</tr>
<tr>
<td><strong>Capacity</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Hide</strong></td>
<td>Hide the vertical shadow bar that highlights the reserved and/or event start times and end times when a user moves a booking in the Reservation Book.</td>
</tr>
<tr>
<td><strong>Booking</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Shadow</strong></td>
<td></td>
</tr>
</tbody>
</table>

7. To select which items to include in the **tooltip** that opens when you place the cursor over an event in the Reservation Book:
   a. Click **Options** (upper-right corner of Reservation Book) to open the Book Options dialog box.
b. Open the Tooltip Display tab and select which items to include in the tooltip that opens when you rest the mouse pointer on an event in the Reservation Book.

8. To change the display date using the calendar:
   a. From the Date field, click the dropdown arrow to open the Calendar.
   b. Use the (< and >) scroll features at the top of the calendar to change the month or use the (>) scroll features at the top of the calendar to change the year.
   c. To select a different date for a month, click the date.

9. To change the display date using the Reservation Book scroll features:
   a. Use the scroll features at the top of the reservation book display to scroll to a different day, week, month, or any different combination of these.
   b. To reset the display immediately to the current day’s date, click Today.

VIEW RESERVATION INFORMATION

1. On the EMS toolbar, click the Book icon. The Reservation Book opens in the Daily view.

2. To view the reservation in the Navigator, double-click the middle bar for the reservation entry or right-click the reservation entry and on the context menu that opens, click Open.
3. You can view the reservation information in the following ways:
   » View the **bookings** for a room
   » View the **properties** for a room
   » View the **pricing** for a booked room
   » View the **setup** information, event information, or teardown information for a reservation

4. To view the bookings for a room:
   a. Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dialog box. The tab on this dialog box lists all the bookings for the selected room based on the current view (Daily, Weekly, Monthly) and on the date that is shown in the Date field.
   b. To view a booking in the Navigator, select the booking, and then click **Open**.

5. To view room properties:
   a. Click the **room name or code** in the Rooms list to open the Bookings tab for the Room Info dialog box.
   b. Open the **Room** tab. The tab on this dialog box lists all the properties for the room, such as the room code, the room name, the room classification, etc. It also lists the setup type and capacity for the room, and any notes that have been entered for the room.
6. To view the pricing for a booked room:
   a. Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dialog box.
   b. Open the Pricing tab. This tab displays any pricing information that was defined for the room.

7. To view the room setup information, event information, or teardown information for a reservation:
   a. Rest the mouse pointer on the left bar, middle bar, or right bar for the reservation entry. A tooltip showing the respective setup, event, or teardown information opens.
   b. If buildings that are located in multiple time zones are currently displayed, you can specify the time zone in which to view all of your bookings.

MAKE A NEW RESERVATION

1. On the EMS toolbar, click the Book icon. The Reservation Book opens in the Daily view.
2. Change the display to show the room for which you are making the reservation.
3. Select the date for which you are making the reservation.
4. In the Time Grid for the room, click and hold the left mouse button, drag the mouse to schedule the room and time, and then release the mouse button to open the
Reservation Wizard. See Also: Make a Reservation Using the Reservation Wizard.

EDIT AN EXISTING RESERVATION

1. On the EMS toolbar, click the Book icon. The Reservation Book opens in the Daily view.

2. Optionally, you can do one or more of the following to edit an existing reservation:

<table>
<thead>
<tr>
<th>STEP</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the setup time for a reservation</td>
<td>Drag the left bar horizontally to a new time. Click Yes in the Confirm Change dialog box.</td>
</tr>
<tr>
<td>Change the event time</td>
<td>Drag the middle bar horizontally to a new time. Click Yes in the Confirm Change dialog box.</td>
</tr>
<tr>
<td>Change the teardown time for a reservation</td>
<td>Drag the right bar horizontally to a new time. Click Yes in the Confirm Change dialog box.</td>
</tr>
<tr>
<td>Edit the reservation building, room, time, or both</td>
<td>Drag and drop the reservation to a new room that is the same</td>
</tr>
</tbody>
</table>
3. Optionally, you can right-click on a reservation in the Reservation Book, and on the context menu that opens, select one of the following:

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens a reservation in the EMS Navigator.</td>
</tr>
<tr>
<td>Move Forward</td>
<td>Move the reservation date forward by one day or one week.</td>
</tr>
<tr>
<td>Move Backward</td>
<td>Move the reservation date backward by one day or one week.</td>
</tr>
<tr>
<td>Move to a Specific Date</td>
<td>Move the reservation to a specific date.</td>
</tr>
<tr>
<td>Change Status</td>
<td>Change the status of the reservation.</td>
</tr>
<tr>
<td>Copy Bookings</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**NOTE:** Although this option is available on the context
<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Swap Rooms With Another Booking</td>
<td>Swap the room assignments of two events. The swap option is applicable only for two events that have identical meeting patterns.</td>
</tr>
<tr>
<td>Highlight Related Reservations</td>
<td>Highlights the bookings that belong to the same reservation.</td>
</tr>
</tbody>
</table>

menu for a reservation, its associated functionality is currently under development.
CHAPTER 44: Troubleshoot an Internal Server Error When Viewing My Events in EMS Web App

If you are getting an internal server error when trying to view existing bookings through the “My Events” page in EMS Web App and there are a large amount of bookings under your name, this is because the number of records returned exceeds the number allowed by the IIS web app configuration. The maximum is set to 50,000 by default.

**Workaround:** You or your System Administrator can increase this limit by editing the web.config file. The configuration attribute to look for is the following:

```
<add key="aspnet:MaxJsonDeserializerMembers" value="50000" />
```

Change the value to the maximum number of bookings you expect users to have.

**Tip for EMS Cloud Customers:** Modifications to the web.config file must be performed by EMS Cloud Operations. To request these changes, please...
contact EMS Support.

CONTACT CUSTOMER SUPPORT

» **Option 1 (Recommended):** Search the Knowledge Base available in the EMS Customer Portal.

» **Option 2:** Submit a Case directly via the EMS Customer Portal.

» **Option 3:** Email support@emssoftware.com.

» **Option 4 (Recommended for critical issues only):** Phone (800) 288-4565.

**IMPORTANT:** If you do not have a customer login, register here.
CHAPTER 45: Understand Everyday User Templates

WHY ARE SOME FEATURES IN EMS UNAVAILABLE TO ME? WHY CAN'T I BOOK A ROOM?

Your Administrator controls what you are able to do and view in EMS using "everyday user templates" based on your user profile. The options and information you can see in EMS depends on your security access, user type, and many other administrative controls.

Additionally, your capabilities are also controlled by your "booking templates" and permissions. To learn more about these settings, see Create a Reservation in the EMS Web App.

NOTE: If you have previously used older versions of EMS, you may know these templates as "Web Process Templates." These templates are now called "Everyday User Process Templates."

See Also: Configure Everyday User Templates.
CHAPTER 46: Skype for Business in the EMS Web App

Everyday Users can now integrate audio/video conferencing tools with EMS applications, starting with Skype for Business. It will no longer be necessary for users to simultaneously create a separate meeting to enable an audio/video conferencing component to their meetings. The EMS integration of Skype for Business allows users to easily integrate instant messaging and audio/video conferencing to their meetings without the need for A/V support.

**IMPORTANT**: When considering using the Skype for Business Integration, keep in mind the following:

- Skype for Business is **ONLY** available on Exchange-enabled templates.
- Users **cannot** edit or remove Skype for Business meetings from their reservations. Users can delete the link, but the **Join** link will remain enabled.

For more information about Configuring Skype for Business, see [Configure Skype for Business](#).
This topic provides information about the following:

- Add Skype for Business to Your Reservation
- Join a Skype for Business Meeting from the EMS Web App

ADD SKYPE FOR BUSINESS TO YOUR RESERVATION

There are multiple ways to add or remove Skype for Business to your reservation.

1. Open and log into the EMS Web App.
2. Begin creating your reservation.
3. You will see an Add Skype to Reservation toggle on both the Room & Attendees and Reservation Details tabs. Skype for Business can be added to your reservation from either of these tabs.
4. If this is your first time adding a Skype for Business meeting in the Web App, a Skype authentication dialog box will appear.
5. Click **Continue to Login**. In the new browser window, enter your email address and password to authenticate your Skype for Business account.
   - If the user’s Skype account is authenticated, they can continue creating their reservation.
   - If the user’s Skype account is not authenticated, an authentication modal will appear.
   - If the user fails to authenticate their Skype account, the Skype toggle will be disabled.

6. Once the Add Skype to Reservation toggle is set to **On**, a confirmation will appear at the top of the screen indicating that Skype information will be added once
you've completed your reservation.

NOTE: The user who created the meeting will be able to view the
Skype for Business meeting details (including Skype meeting link and
call-in information) from the Browse Events, Browse Locations, and
Browse People screens.

Once you have added Skype to your reservation, the meeting attendees
will receive an email notification including the Join Skype link and call-
in information.

7. To remove Skype for Business from your meeting, set the Add Skype to Reser-
vation toggle from either the Room & Attendees or Reservation Details tabs to Off.
A message will appear at the top of the screen, confirming that Skype information
has been removed from your reservation.
JOIN A SKYPE FOR BUSINESS MEETING FROM
THE EMS WEB APP

Note: You can join a Skype for Business meeting that has been added to your reservation from multiple places in the EMS Web App:

» My Booking Details Modal
» View Reservation

1. From My Events, navigate to the Reservation Tasks column on the Reservation Details tab. Click the Join Skype icon to launch your Skype for Business meeting.
2. From the **Booking Details** page, navigate to the **Event Details** tab. At the bottom of the **Event Details** tab, click the **Join Skype** button to instantly launch your Skype for Business meeting.

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Pat’s Planning Meeting</th>
<th>edit(1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Monday Apr 17, 2017</td>
<td></td>
</tr>
<tr>
<td>Event Time</td>
<td>9:00 AM - 5:00 PM MT</td>
<td></td>
</tr>
<tr>
<td>Reserved Time</td>
<td>9:00 AM - 5:00 PM MT</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>Workspace 2 - EMS Software HQ</td>
<td></td>
</tr>
<tr>
<td>Skype Meeting Info</td>
<td>Meeting ID: 12532</td>
<td></td>
</tr>
<tr>
<td>Employee</td>
<td>Pat Smith</td>
<td></td>
</tr>
<tr>
<td>1st Contact Phone</td>
<td>720-531-4318</td>
<td></td>
</tr>
<tr>
<td>1st Contact Email</td>
<td><a href="mailto:pat.smith@emssoftware.com">pat.smith@emssoftware.com</a></td>
<td></td>
</tr>
<tr>
<td>Reservation ID</td>
<td>48312</td>
<td></td>
</tr>
<tr>
<td>Event Type</td>
<td>Meeting</td>
<td></td>
</tr>
</tbody>
</table>

For more information regarding features of Skype for Business, please see the [Microsoft Skype for Business User Guide](#).